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The Road to Creativity
Travel this road to the 2005 Creativity Retreat sponsored by BERNINA®!

Petit Poche 
This easy-to-make “little purse” is constructed of wool, and embellished with needle-punched
accents.

Making Changes – An Introduction to Embroidery Editing
Learn to personalize your embroidery and fulfill your creative visions.

Beautiful Buttonholes
Use BERNINA® sewing machines, as well as embroidery systems and software, to make
buttonholes to suit any garment, fabric type, or design style.

Quilting 101
This introduction to quilting techniques covers both walking foot and freemotion techniques,
including the new BSR (BERNINA® Stitch Regulator).

See It, Scan It, Sew It
Start with your original artwork, import it into your computer, and turn it into a rich
embroidery design.

The Art of Appliqué
This special 12-page section has everything you need to begin or improve your technique:
Appliqué Fundamentals, Appliqué Techniques, and Appliqué Plus.

High Falutin’ Fairy
The centerpiece of this colorful mini-quilt features the artwork of elinor peace bailey, known
for her fun spirit and unique dolls. 

Simple Scrapping
Design a page around one “wow” photo, printed on fabric and stitched to paper.

Sewing Machine TLC
Extend the life of your sewing equipment by treating it well and staying on top of routine
maintenance. 

Quilter’s Toy Box
Try your hand at appliqué, foundation piecing, and creating new blocks using the Designer
Plus level of BERNINA® Embroidery Software. 

Designs All Around
New hoops from Hoop-It-All™ make it easy to stitch extra-large designs.

Initially Yours
Add a bit of editing magic to a traditional monogram and it becomes something unique. You’ll
never look at monograms the same way again!

Puzzle Pieces: Dividing Large Designs
Try this practice exercise to learn how to divide and stitch embroidery designs larger than the hoop.

Serger Smocking
Blend beautiful silks and decorator fabrics with the serger’s unique differential feed feature
to make people wonder, “Just how did she do that with a serger?”

Software Scrapbooking
Use the BERNINA® Quilter software program to design a visual page layout – a guide for
assembling your scrapbook page.   

To Koos and Beyond
Create purses, bags, hats, and even shoes with the embellishment techniques inspired by
renowned designer, Koos van den Akker.

Tassels, Trims, and Stellar Stitches
This elegant pillow features decorative quilting stitches and a beautiful embroidery design from
the special Tassels and Trims design collection included with the Tassels and Trims book.
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MARLIS BENNETT
As an Education Consultant for BERNINA® of America, Inc., Marlis
creates unique interpretations of classic and heirloom garments,
putting her own stamp of creativity on machine sewn projects.

JENNIFER GIGAS
Jennifer, an Education Consultant for BERNINA® of America,
Inc., combines serging, sewing, and embroidery in her updated
versions of favorite patterns.

LYN LACKEY
Currently a District Sales Manager for BERNINA® of America, Inc.,
Lyn is a former BERNINA® Educator, and has taught a wide range
of sewing classes including quilting, heirloom and embellishment.

CINDY MICHAELS
Before becoming a BERNINA® Educator, Cindy worked for 12
years for a BERNINA® store in Southern California as a teacher
and sales person, both in-store and at fairs, home shows, and
quilt and craft seminars.

PAT JENNINGS
A BERNINA® Educator, Pat was part of the original artista
sewing/embroidery development team, and now directs the artista
200 Portal and the myartista section of www.berninausa.com.

JILL DANKLEFSEN
Jill’s exquisite work with manipulating decorative stitches –
playing with them, changing them, creating texture with them –
is one of her specialties as a BERNINA® Educator

HANS HERZOG
The Technical Education Manager for BERNINA® of America, Inc.,
Hans creates technical education material for BERNINA® dealers.
He is in close contact with the factory in his homeland,
Switzerland.

FAITH REYNOLDS
As a BERNINA® Educator, Faith teaches national classes for
both dealers and consumers. One of her favorite topics is the
use of the BERNINA® Embroidery Software.

NANCY BEDNAR
Nancy is a BERNINA® Educator and is co-author of The
Encyclopedia of Sewing Machine Techniques. Her new book,
Creative Serging: A Comprehensive Guide, is due for release
Spring of 2005.
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ONE OF THE JOYS OF SEWING IS PLAYING WITH FABRIC AND THREAD – learning new techniques,
staying on top of the newest prints and textures, and experimenting with new colors and combina-
tions. Another is playing with the most up-to-date “toys” –  presser feet, accessories, machines. 

BERNINA® has always been an education-based company, helping consumers stretch their stitching
boundaries and get the most from their sewing room equipment. That’s one of the reasons we
participate in consumer shows around the country, teaching classes and conducting seminars,
and publish Through the Needle magazine – we want to offer as much of our sewing expertise to
sewers as possible, to expose both beginning and experienced stitchers to the newest innovations in
the sewing world.

One of the greatest treasures of sewing is getting together with passionate stitchers,
spending time with others that share our common obsession with fiber and
fabric. So, in addition to consumer shows around the country, BERNINA® is
also hosting our second Creativity Retreat, to be held in August 2005, just
outside Chicago.

Come join us for 3+ days of hands-on and lecture/demo classes covering
sewing, serging, embroidery, and software projects and techniques. Here’s

what attendees from last year had to say about our first Creativity Retreat, held in April 2004:

“This was a lot more than I expected. I am absolutely in love with BERNINA®. Thank you for
showing me BERNINA® heaven.” – Jennifer Chin 

“The fashion show was wonderful. It was a learning experience to see the garments up close. I was
happy that the classes were not all for quilting or crafts and contained information and techniques
for garment sewers.” – Unknown

“…usable class projects to take home which taught appropriate skills.” – Beth Engbrecht

This year’s retreat will feature two of the most creative designers/teachers we know – Kayla
Kennington, a wearable art designer and a 2-time winner of the BERNINA® Fashion Show, and elinor
peace bailey, a truly talented artist and doll maker.

Visit the BERNINA® web site (www.berninausa.com) to register. Hope to see you there!

COME TO CLASS
• Martha Pullen School of Art Fashion, Huntsville, AL – February 6-13, 2005 – www.marthapullen.com
• Mid-Atlantic Quilt Festival, Hampton, VA – February 24-27, 2005 – www.quiltfest.com
• Sewing and Stitchery Expo, Puyallup, WA – March 3-6, 2005 – www.sewexpo.com 
• Quilter’s Heritage Celebration, Lancaster, PA – March 31-April 3, 2005 – www.qhconline.com
• National Quilting Association, Columbus, OH – June 16-18, 2005 – www.nqaquilts.org
• Martha Pullen School of Art Fashion and Kids School, Huntsville, AL – July 17-24, 2005 –

www.marthapullen.com
• BERNINA® Creativity Retreat, Lisle, IL – August 25-28, 2005 – www.berninausa.com
• Pennsylvania National Quilt Extravaganza, Ft. Washington, PA – September 15-18, 2005
• ORIGINAL SEWING & QUILT EXPO – www.sewingexpo.com:

- Harborview Center, Clearwater, FL – February 24-26, 2005
- Gwinnett Center, Atlanta, GA (Duluth) – March 10-12, 2005
- I-X Center, Cleveland, OH – March 17-19, 2005
- DCU Center, Worcester, MA (Boston) – April 14-16, 2005
- Dulles Expo Center, Chantilly, VA (Washington, DC) – September 29-October 1, 2005
- Donald E. Stephens Convention Center, Rosemont, IL – October 6-8, 2005
- Overland Park Convention Center, Kansas City, KS (Overland Park) – October 13-15, 2005
- Sheraton Bloomington Hotel Minneapolis S, Minneapolis, MN (Bloomington) – Nov 10-12, 2005

from BERNINA®

GAYLE HILLERT
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A
s we travel through life, we take many paths that lead to various experiences, some good,
and some not-so-good. One of the pathways or roads that brings satisfaction and fulfillment
is the road to creativity. We all travel this road in different ways but for those of us who sew,

there is a bond in the elements that attract us, enthuse us, and delight us – fabric, thread, stitches,
fibers, color, texture, and the possibilities that these offer.

BERNINA® understands these bonds and strives to nurture and
encourage them – for beginning stitchers and for the more
experienced. The first Creativity Retreat in 2004 offered a venue
for this nurturing process and was so successful, it’s going to
happen again! On August 25-28, sewing enthusiasts will converge
on Lisle, IL, just outside Chicago. They will share 3+ days of
classes, fun, sharing, shopping, laughter, and learning. The topics
cover a wide variety of needle techniques including embroidery,
quilting, needle felting, serging, embellishment, and garment
making, all taught by talented BERNINA® Educators. 

The keynote speakers for this event are two designers who are
sure to amuse and inspire. While the artistic endeavors of Kayla
Kennington and elinor peace bailey span a variety of genres, and
each has different areas of sewing expertise, both offer exciting
avenues of creative expression. 

As a couture artwear designer, Kayla loves making runway
masterpieces and is a 2-time winner of the Crème de la Crème
award at the BERNINA® Fashion Show. She continues to
participate in the show, but her garments are no longer judged
so that the other designers have a chance to win! She also
designs garments for her pattern collection, Modular Designs
for Couture Artwear, which features unique, individualized
clothing items that can be worn by anyone. The shapes are
simple, modular pieces that fit together from one pattern to
the next. For example, a sleeve from one pattern can be
combined with the body of another one. The designs are
simple to construct using Kayla’s unique seaming
techniques. The styles may look boxy when laid flat;
however, when made from the recommended soft, drapey
fabrics – such as silk, rayon, and velvet – the garments
flow over the body and create a flattering silhouette.  

"A walking advertisement for fun" is how someone once
described elinor peace bailey. With her bright clothing,
outgoing nature, and lively sense of humor, it is obvious that
elinor is not your "typical" sewing teacher. A globe-trotting
teacher of dollmaking who designs fabric and exercises her
talent as a graphic artist on any stray
surface she can find, elinor travels
about 200 days a year, teaching
and sharing her unique designs
for dolls, toys, and other
stuffed creations.

For more information 
about the Creativity 
Retreat from BERNINA, visit
www.berninausa.com

Learning with Barbara

Happy faces

Fun in class

Going, going, gone!

CREATIVITY RETREAT 2004



C
reativity + fabric + women – it's just a magical combination! Our grandmothers knew it, their
grandmothers knew it, and here we are. Some of us are grandmothers ourselves (I am), passing
along our love of sewing! This feels good to me, it feels right, I feel so "on my path" when I'm

sewing, when I'm teaching sewing, and even when I’m just talking about sewing.

I’m interested in getting younger sewers started. I remember when I
got my first pattern and realized so much of the instructions were
"assumed". I got so frustrated, I just threw the instructions across the
room. But I didn't give up. I used the pieces – the big pieces only. I
still refuse to use facings, zippers and buttonholes. 

Influenced by my Grandmother, I developed my
own style of sewing. She never used patterns.

She would hold the fabric up to me and cut
away what we didn't need and sew the
pieces together. 

I understand it's a bit different than the
"home economics classes" in school type

of sewing (although I really envy those able
to do that fine tailoring style!). My very first

garment (at age 4) was made from two of my
Grandfather's "shop hankies" (bandana scarves).

Grandma had me sew them together at the shoulders and side seams – voila – a top! I wore it every
day for an entire week. My first Modular Design! 

I like using very simple shapes, wonderful fabrics, and connecting them with beautiful, clean
seams. I found ways to sew beautifully that do not require a great deal of skill, and I promise
impeccable results. 

I love the challenge of learning new technologies, and integrating them with the traditional
sewing styles of the past. I feel compelled to carry forward our special history of needlework in
new and exciting ways. My personal design style has evolved over the years as I have added
new techniques, both innovative and traditional, to my repertoire of design and sewing skills.

My designs usually begin with a vague image I've been playing with in my mind
and elements of designs I've done in the past. Sometimes it takes years until the

idea feels "ready" to begin.

One day, while wandering a quilt show, I found the Fairfield Fashion
Show display and I thought, "Wow, I'd like to do that." Unfortunately,

I discovered that it was the last year of the Fairfield
Show. However, I got lucky – BERNINA® picked up

the show. I sent in a portfolio of the showpieces
I had created in the past for review. A few
months later, I received a letter that I had
been chosen as one of the 50 designers to
participate in the new show. And then…I won!
The Crème de la Crème Award and a top-of-
the-line BERNINA® and software worth $6,500!

I have always enjoyed being "wildly creative,"
and now my BERNINA® affords me a pride in

workmanship I never dreamed possible.

S P E C I A L  C L A S S R O O M  E D I T I O N

5

www.kaylakennington.com
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W
ho gets to make art? Anybody who wants to! Being creative is a common experience for
everyone. Don’t worry about content – the process will take you somewhere and is valuable in
and of itself.

If you can’t see what you want in your head, you’re still looking for something to reproduce. You may need
to look for inspiration in magazines, art books, craft books, nature, whatever helps define the ideas in your
head and give you a vision of what you want to create.

If you have a vision and see it in your head, don’t do as some
artists do: start creating, and if the result doesn’t match what is
in their heads, it is put aside and judged unacceptable. You
may be able to learn from your creative struggles. If your
attempts aren’t giving you the results you want, then your
problem may be technical – try different techniques and keep
going!

The creative experience is not reserved for the few. As long
as you don’t care what kind of art you make, you can make
art all the time. So, no excuses…get on with it!

Remember, making bad art
is better than making no
art at all!

www.epbdolls.com



BY MARLIS BENNETT

Marking The Design
• Transfer the needlepunch design (see pattern) to stencil plastic with indelible marker.

• Place the marked stencil plastic on the picture frame glass.

• Trace the design with a hot stencil cutter. (Do not connect lines or the shape
will drop out of the stencil.) 

• Place the template on the right side of one piece of felted wool (note placement
on pattern and on finished purse shown in photo).

• Pounce with chalk bag to transfer markings
to wool.

This petite poche or “little purse” is 
easy to make and is the perfect size for 

holding “just the essentials”.

Finished size: 71/2” x 10” 

excluding handles

Supplies:
• 2 pieces felted wool, 12” x 9”

each

• 1 yard wire-edged ribbon for
handles

• Sewing thread to match wool

• 4” square OESD Tear Away
stabilizer

• BERNINA® Decorative
Needlepunch Attachment 

• BERNINA® Walking Foot #50

• BERNINA® Buttonhole Foot
#3/3C, #3A/3C, or #3B

• Rotary cutter with wavy blade
and cutting mat

• Stencil plastic

• Indelible marker

• Stencil cutter

• Small piece of picture frame
glass

• Chalk pouncing bag

• BERNINA® Buttonhole Cutter
and Wood Block

• Appropriate fiber for
Decorative Needlepunch
Attachment (pink, white, and
green)

Pyn Pillow 
Watermelon Kit

Shown here is a kit for a wool pincushion and
thimble holder. The wool roving in this kit is
perfect in fiber and color for punching the
design on the Petite Poche.

S P E C I A L  C L A S S R O O M  E D I T I O N
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Punching The Design
• Attach Decorative Needlepunch Attachment to machine following instructions

included with the attachment.

• Pinch a 1/2” piece of white roving; pull and cut a 11/2” length.

• Fan out one end of roving.

• Place over flower portion of design.

• Punch roving into wool.

• Pull off a small portion of pink roving.

• Overlay white flower with pink roving, concentrating saturation at base of flower.

• Repeat above steps for second flower.

• Fill in leaf with green roving.

• Twist 1/4” thickness of green roving to form stem and punch to wool in stem
locations.

Purse Construction
• Layer both pieces of felted wool.

• Use rotary cutter with wavy blade to cut
purse out using pattern as a guide.

• Attach Buttonhole Foot to machine.

• Back each buttonhole area with Tear
Away stabilizer. Sew two 11/2” button-
holes on each purse piece, placed as
shown on the pattern. 

• Cut buttonholes open and remove
excess stabilizer.

• Attach Walking Foot #50 to machine.

• Select straight stitch.

• Pin both layers of wool together.

• Place edge of Walking Foot along outermost edge of wavy cut wool.

• Sew around purse (leave top open) with straight stitch, securing both starting and
stopping points.

• Cut wire edge ribbon into two 18” lengths.

• Thread ribbon through buttonholes so that the cut ends are on the outside of
the purse. Tie knots approximately 1” above cut ends.

Fabrics and Fibers
Fabrics: Most sewers immediately think of using
heavyweight or felted wool for needlepunch. While this

fabric works beautifully for
needlepunching, it is not the

only base fabric that will
work. Experiment with the
following: 
• Denim – all weights
• Chamois
• Cotton duck

• Wool felt
• Canvas 

• Mid-weight fabrics such as
twill

• Tightly woven lightweights –  experiment on a test
piece first. Note: Multiple needle punctures are hard
to hide on lightweight fabrics.

Fibers: Wool roving or untwisted wool knitting yarns are
an obvious choice for needlepunching. It is hard to pass
up the lush, full appearance that lends itself so well to
this technique. Look for variegated yarns to get a lot of
color mileage with your purchase. Also consider:

• Other types of knitting yarn, such as worsted wool,
cotton yarns

• Silk ribbon 

• Hand-dyed Tencel®

• Metallic, tinsel threads

• Spiky, textured fibers such as QRI’s Designer Threads

T H R O U G H  T H E  N E E D L E
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Decorative 
Punch Tool
Check List

Remove...

• needle
• needle thumb screw
• presser foot
• stitch plate
• bobbin case
• bobbin hook

Attach...

• punch tool stitch plate
Note: Select the correct
stitch plate for your BERNI-
NA® machine model.

• punch tool presser foot
• punch tool needle holder
• punch tool needle holder

screw

Set Up...

• feed dog down
• straight stitch selected
• bobbin area door open
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Purse Pattern
Cut 2 of fabric



Making
Changes

An Introduction to 
Embroidery Editing

T H R O U G H  T H E  N E E D L E
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Basic editing software provides the means to alter an existing embroidery design to suit
your project. You are no longer limited in your embroidery design selection.

Regardless of the color, size or style of the project, editing software helps you personalize
embroidery designs to fulfill your creative vision. The BERNINA® Embroidery software
features discussed in this article allow you to make simple changes to your designs,
customizing them to your liking.

Note: All software references in this article are to Editor Lite (included with the BERNINA®

models aurora 430E and 440 QEE embroidery systems) and also apply to the other
levels of BERNINA® Embroidery Software (Editor, Auto Designer, Designer Plus).

OPENING AN EXISTING DESIGN
Editor Lite has 64 ready-to-stitch pure .art files. Pure .art files provide maximum editing
flexibility with the best results. Designs from cards, multi-format CD’s or purchased from
www.embroideryonline.com may be easily imported into the BERNINA® Embroidery
software for editing. (Please refer to your owner’s manual for specific information on
importing designs.)
To open a design:
• Select File > Open > My Designs (My Designs is automatically installed on the C Drive).
• Select Border Black 2; click open. 
• The design appears on the design screen. 

SELECT OBJECT
Before an embroidery object may be manipulated or edited, it must be selected. First,
activate the tool and then, select the object. The selected object will turn magenta.
• Select an object by left-clicking on the Select Object tool.
• Left-click on the object you wish to select, or draw a boundary box around the object. 

MIRROR IMAGE 
Use the Mirror Image tools to mirror the object horizontally, vertically, or both. When
embroidering designs for opposing sides of a project, mirror imaging the designs will
result in a more professionally finished project.

• Select the design you wish to mirror.

• Click on the Mirror Image tool representing the direction in which to mirror the design.

BY JENNIFER GIGAS

horizontal 
mirror

original 
design

vertical 
mirror

original 
design
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ROTATE CCW/CW
Quickly rotate an embroidery object by 45˚ using the Rotation Tool. Left click to rotate the
motif counterclockwise; right click to rotate clockwise. Objects may be freely rotated by
clicking twice and dragging the rotation handles around the motif. Degree of rotation may
also be set through the Object Properties dialog box. (Please refer to your owner’s
manual for specific information.)
• Select the design you wish to rotate.
• Left click on the Rotate CCW/CW icon. The design is rotated to the left. Undo
• Right click on the Rotate CCW/CW. The design is rotated to the right. Undo
• Left click in the center of the motif. The corner handles are now open squares. Click

and drag the motif to the desired degree of rotation. Click and drag the center point to
move the point around which the design is rotated.

SCALE BY 20% DOWN/UP
One of the advantages of working with .art files and BERNINA® embroidery machines is
the ability to rescale designs. When a design is scaled, it is recalculated to add or
remove stitches from the design to keep the density the same as the original. The Scale
tool provides quick scaling in 20% increments. Left click to reduce the size of the design,
right click to increase. Scale the design by clicking and dragging the handles that
appear when a motif is selected. Design size may also be set through the Object
Properties dialog box. (Please refer to your owner’s manual for specific information.)
• Select the motif.
• Left click on the Scale icon to scale down 20%. Undo.
• Right click on the Scale icon to scale the design up 20%. Undo.
• Click and drag a corner handle to scale the design proportionally. Click and drag a

point on the top to alter height only. Click and drag a side point to alter width only.

LETTERING/VALUES 
Editor Lite software includes 5 scalable embroidery fonts. (Editor, Auto
Designer, Designer Plus include 50 fonts; in addition TrueType fonts may
be used with Designer Plus.) Monogramming or adding lettering to an
existing design is a wonderful way to personalize a project. (Please refer
to your owner’s manual for advanced lettering information.)
To add lettering:
• Left click on the Lettering/Values icon.
• Click on the location on the design screen, where you would like to

position the lettering.
• Type your text, it appears on the screen.
• Press Enter to generate the lettering object.
• Lettering may be edited - scaled, rotated, or mirrored - just like any other object.

RESHAPE LETTERING
Note: The Reshape icon allows the reshaping of lettering
in the Editor Lite program. The reshaping of any embroi-
dery object, not just lettering, is possible in Editor, Auto
Designer and Designer Plus

Individual letters may be reshaped to create just the look
you want for your project. To reshape:

• Select the lettering; select the Reshape icon.
• Click on the letter’s

center control point;
click on the outline
of the letter.

• Boundary control
points will appear.
These may be
moved to alter the
shape of the letter
and the stitch angle.

click on letter boundary 
control points

move points 
to alter shape

and stitch
angle

TOOLS 
Spend time becoming familiar with the various
editing tools available in your embroidery
software. Once comfortable with the function of
each tool, you will find exciting and innovative
ways to combine the features of your software
program. Refer to your owner’s manual often –
there’s a wealth of information generally
overlooked in this valuable resource. The
following icons represent several common
editing tools that are used frequently.

Select Object

Mirror Image Horizontal

Mirror Image Vertical

Rotate CCW/CW

Undo

Scale by 20% Up/Down

Lettering/Values

Reshape Lettering
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BY LYN LACKEY

Buttonholes can be functional or decorative, and in many
cases serve both purposes. A basic in garment construction,
buttonholes are offered to the sewing enthusiast in a myriad
of choices on the sewing machines of the 21st century. With
the wonderful buttonhole choices on BERNINA® sewing
machines and the unique ability to create buttonholes in the
BERNINA® v4.0 Embroidery Software, buttonholes truly can
be made-to-measure and personalized to suit any garment,
fabric type, or design style.

Basic Buttonhole Feet 
Almost every sewing machine makes a basic buttonhole and
has a buttonhole foot included as a standard accessory.
BERNINA® machines are able to make the tiniest of button-
holes or stitch one as long as needed – even large enough
for a pocket opening. Always select the correct buttonhole
foot for the job as described below:

Automatic Buttonhole Foot 
with Slide #3A/3C 
Designed for programmed
buttonholes that stitch automatically.
This foot has a sensor to detect the
length of the first buttonhole stitched,
then repeats that buttonhole until the
size is changed. This foot is included

with most BERNINA® sewing machines. As the buttonhole is
stitched, the raised “sole” glides over the fabric, while a
“rubber-treaded” sole grips the fabric and travels backward
and forward with it. The sliding gauge makes it easy to
measure the length of the first buttonhole accurately.

Buttonhole Foot #3/3C
Used when making a single
buttonhole, buttonholes larger than
29 mm, and when stitching
buttonholes in hard-to-reach areas.
The sole of this foot has two grooves
that allow the fabric to move freely
over the heavy build-up of thread

that forms the buttonhole. Each side or “bead” of the
buttonhole fits into one of the grooves so the foot will move
smoothly. The slight indentation on the sole in front of the
needle assures that the foot can easily move over the thread
as the stitching reverses to complete the buttonhole.

Buttonhole Foot with Slide #3B
Foot #3B works with all BERNINA® machines but was
designed for those without an automatic buttonhole. The

sliding gauge makes it easy to duplicate
buttonholes manually, repeating the same
size over and over. As the buttonhole is
stitched, the raised “sole” glides over the
fabric, while a “rubber-treated” sole grips
the fabric and travels backward and
forward with it.

bernette (models 65, 80e, and 90e)
Buttonhole Foot
Requires a button to be placed in a slot
on the foot to regulate the size of the
buttonhole. 

Making Buttonholes
Automatic Buttonholes
Equipped with an electronic
sensor, Automatic Buttonhole
Foot #3A/3C works with most
computerized models of
BERNINA® sewing machines. 
The machine memorizes the size

Keys to Success
• Mark accurately, placing buttonholes about 5/8” from the

garment edge.

• Always stabilize and interface buttonholes adequately,
choosing a stabilizer and/or interfacing that comple-
ments the weight of the fabric, so that the buttonhole
area is neither too stiff nor too limp. 

• Always make a practice buttonhole using the same
fabric, interfacing, stabilizer, threads and needle that
will be used on the project to assure that they all work
well together.

• Coordinate garment style and fabric with the type of
buttonhole; choose buttons and embellishments that
complement or enhance the look of the finished gar-
ment. 

• Seal the cut edges of the buttonhole with a fabric
sealant.
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of the stitched buttonhole; it then duplicates this buttonhole
as many times as needed. The artista machines can save
any style buttonhole in a variety of lengths.

Corded Buttonholes
Buttonholes stitched over
cord offer an option for very
heavy fabrics as well as a
way to add stability to
buttonholes on knit fabrics.
High points of wear and
stress can also benefit from

a corded buttonhole. The cord gives the buttonhole a more
pronounced look so it is also a good choice when using
buttonholes as a design element or a focal point of a garment.

This technique can be applied to any rectangular buttonhole.
Supplies/Settings: Match needles to fabric, slightly loosen
needle tension, and use a fine cord such as perle cotton #8,
crochet cord, embroidery floss, or gimp cord as a filler. An 
all-purpose polyester thread in the needle and bobbin offers
stability and strength as does silk-finish cotton. 

BERNINA® buttonhole feet are
designed to hold a looped cord 
in position during the stitching
process. To position the cord,
put the needle down in the
fabric at the exact start of the
buttonhole and raise the
presser foot. Hook the center of
the cord over the hook at the

back of the foot and pull the ends to the front of your machine
under the foot. Secure the tails on either side of the “knob” at
the center front of the foot. The loop of the cord should be
placed at the end that will take the most stress, usually the
upper end of the buttonhole or the one nearest the edge of the
garment. Note: For the standard Buttonhole Foot #3/3C, loop
cord from front to back, leaving ends loose behind the foot.
The cord will lay in the grooves under the foot and allow the
foot to move freely over the stitches.

After stitching the buttonhole and removing the project from
the machine, pull the ends of the cord to move the loop into
the buttonhole. For woven fabrics, pull tight enough to pucker
the buttonhole slightly. Trim the ends of the cord and flatten
the buttonhole, making the cord ends disappear inside each
bead. For knitted fabrics, thread the ends of the cord to the
wrong side and tie to secure.

When sewn on heavy fabric, such as for a coat or jacket,
corded buttonholes add stability and protect the garment
against wear and tear. If the fabric is thick, place water-
soluble stabilizer on top of the buttonhole area before
stitching. As you sew, the stitches will not sink into the deep
fabric but remain on top to prevent any size distortion. Tear or
wash away stabilizer when buttonhole is complete.

Delicate Buttonholes
Buttonholes for delicate fabrics, such
as those used in heirloom sewing,
require a finer, less dense buttonhole.
If your sewing machine has a narrow
and/or hand-look buttonhole, these
are the best choices for these

projects. Use extra fine thread (size 60 or 80) on top and
bottom to produce a finer, less bulky buttonhole. If your sewing
machine does not have a narrow buttonhole, you may be able
to decrease the width of the standard buttonhole using stitch
width or double needle settings to create narrow beading.

Embellished Buttonholes
Add personal charm and creativity
to buttonholes with
embellishments. After sewing the
buttonhole, change to Open
Embroidery
Foot #20/20C

or Clear Embroidery Foot #39. Sew a
sample of the chosen motif to verify size
and placement of the motif in relation to
the buttonhole. Select a decorative stitch

STANDARD BUTTONHOLE
Fine to medium weight fabrics. Blouses, shirts, trousers,
bed linens.

HEIRLOOM BUTTONHOLE
Fine to medium weight fabrics. Blouses, shirts, dresses,
trousers, children’s and baby clothes, doll clothes, 
heirloom work.

STRETCH BUTTONHOLE
All stretch fabrics made from cotton, wool, silk, and 
synthetic fibers.

ROUND BUTTONHOLE WITH NORMAL BARTACK
Medium to heavy weight fabrics of all types. Clothing, 
jackets, coats, rainwear.

ROUND BUTTONHOLE WITH HORIZONTAL BARTACK
Medium to heavy weight fabrics of all types. Clothing, 
jackets, coats, rainwear.

KEYHOLE BUTTONHOLE WITH NORMAL BARTACK
Heavy weight, non-stretch fabrics. Jackets, coats, 
trousers, leisure wear.

KEYHOLE BUTTONHOLE WITH POINTED BARTACK
Non-stretch firm fabric. Jackets, coats, leisure wear.

KEYHOLE BUTTONHOLE WITH HORIZONTAL BARTACK
Firm, non-stretch fabrics. jackets, coats, leisure wear.

HAND-LOOK BUTTONHOLE
For light- to medium-weight woven fabrics. Blouses, 
dresses, leisure wear, bedding, crafts.

STRAIGHT STITCH BUTTONHOLE
For prestitching buttonholes and pocket openings. 
For bound buttonholes & welt pockets.
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Helpful Tools
Buttonhole Compensation Plate
One of the newest accessories from
BERNINA®, the Buttonhole Compen-
sation Plate improves the fabric feed
when sewing buttonholes in heavy or

bulky fabrics.
It is particu-
larly effective
with chenille,
felted wool,
polar fleece,
and fused,
reversible
wools. The

Buttonhole Compensation Plate can only
be used with the Automatic Buttonhole
Feet #3A/3C. It fits the foot, much like a
ski boot fits a binding. 

The application of the Compensation
Plate to the foot is simplified when the
FHS (Free Hand System) is used (or the
feed dog dropped) to obtain maximum
space between the presser foot and the
stitch plate.

The procedure is quite simple: select the
desired buttonhole and attach the foot to

the machine. Slide the fabric between
the two plates, hook the attachment 
to the back of the foot, then attach it to
the whole foot by turning it to the right.
Sew the buttonhole as usual; the
Compensation Plate supports the 
feed of difficult, uneven, or thick fabrics
and allows for even and perfect button-
hole beads. When using fabrics that are
not as thick, it is possible to attach the
Buttonhole Compensation Plate to the
presser foot first, then push the fabric
layers between the two plates.

Napped and/or fuzzy fabrics respond
well when a swatch of water-soluble 
stabilizer such as Aqua Film is placed 
on top of the fabric, under the foot. As
mentioned previously, the stitches will 
not sink into the textured areas of fabric
but remain on top to prevent any size
distortion.

Buttonhole Leveler
The BERNINA® Buttonhole Leveler is
another aid in keeping the foot even and
level so that the beads of the buttonhole
will form perfectly and the fabric will feed
consistently and evenly. This accessory
is ideal for fabrics that are uneven,

napped or
nubby but not
necessarily
bulky or thick.

Buttonhole Cutter and Block
This unique
tool offers a
clean cut for
opening but-
tonholes and
eliminates
the risk of
cutting
through the

end of the buttonhole that seam rippers
and scissors invite. To use, simply place
the block on a stable surface and posi-
tion the buttonhole over the block. Place
the blade of the cutter in the center of
the buttonhole and press down. The
beveled edges of the blade help prevent
accidental cutting of the beads of the
buttonhole.
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and sew the decorative pattern around the buttonhole, on
either side, and/or at each end. Sewing the motif first and
then stitching the buttonhole on top is another option.

To create “eyelash” buttonholes, fold a
length of decorative cord or thread to
form loops, secure to the buttonhole
placement line, and sew the buttonhole
over the thread. Loops may be snipped
or not depending on the look you want to
achieve. 

Software Buttonholes 
BERNINA’s® v4 Designer
Plus Embroidery Software
gives the option of adding
buttonholes to a project
simply by selecting the
Arrange menu and choosing
the Add Buttonhole feature.

After selecting the
buttonhole and the
digitized motif behind
it, engage Merge
Buttonhole to remove
the stitches underneath
the buttonhole,
producing an
embroidered
buttonhole that can be
cut open quickly and
easily.

Create
decorative
buttonholes 
with ease and
perfection:
generate
buttonholes in the software and add
decorative pattern run stitches to
them. Blackwork borders and corner
motifs also add dimension and
characteristic to buttonholes. And
perfection every time!
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PREPARATION 
To prepare your project for
quilting, first create a “quilt sandwich” – a layer of
batting between the quilt top and backing.

• Cut the backing fabric a few inches larger than the top, allowing for some shrinkage
during the quilting process. Cut the batting the same size as the backing.

• Place the backing right side down on a flat surface; use masking tape to keep the
backing flat and smooth. Layer the batting on top of the backing, smoothing it to
remove any wrinkles.

• Center the quilt top right side up on the batting, making sure that the batting and
backing extend beyond all sides of the top.

• Baste the layers of the quilt together using a machine basting stitch, quilters’ safety
pins, or temporary fabric adhesive spray (also called quilt basting spray).

• Create a large, flat area around the machine to support the weight and bulk of the
quilt. This helps prevent distortion of stitches that can be caused by the quilt pulling
away from the machine. For a small wall quilt, it may only be necessary to attach a
slide-on tray or table or lower the machine into a cabinet. For a large quilt, consider
setting a table behind and/or to the left of the machine.

• Large projects can be rolled along one side so that quilting can begin at the center of
the project. Secure with quilt clamps or bicycle clips. Note: An alternative technique is
to loosely accordion-fold one side of the quilt to get it under the needle, stopping as
you stitch to move and maneuver the bulk.

Quilting is the 

stitching that keeps

all the layers – 

backing, batting, and

quilt top – together.

The stitched design

can be simple or

fancy, subtle or 

eye-catching, 

enhancing the 

elements of the quilt

top or ignoring them

completely.
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STITCH-IN-THE-DITCH 
An easy, machine-fed technique utilizing straight lines of stitches to define the seamlines of the patchwork.

• Attach standard sole to Walking Foot #50. Thread machine with cotton thread in the bobbin and cotton or clear monofila-
ment in the needle. Select a straight stitch with a length of about 3mm.

• Beginning at center of quilt, align a seam with the center needle position mark on the foot. Stitch, guiding fabric so that
the needle sews in the “well” formed between blocks and/or patchwork pieces.

• Edgestitch Foot #10 can also be used, depending on the batting; Foot #10 foot also works well to secure a binding in place.

CHANNEL QUILTING
Cover the quilt surface with parallel lines of machine-fed stitching, filling defined areas and creating texture.

• Start the quilting stitch with tiny stitches which eliminates tie offs and then at end of row
press Pattern Begin to get the tiny stitches back again.

• Use a temporary or wash-away fabric marker and a long straight edge to mark a line from
side to side across the area to be quilted, parallel to the edges or at an angle. Attach the
standard sole to Walking Foot #50. Select a straight stitch or hand-look quilting stitch;
thread machine as desired for selected stitch.

• Starting in the middle of the quilt, stitch along the marked line from the center to one side.
Repeat for the remaining half of line.

• Attach right side seam guide; set to desired distance between rows. Working from the center toward the sides, sew paral-
lel rows of stitching, aligning the guide with the previously stitched lines.

GRID QUILTING
Similar to channel quilting, but a second set of perpendicular lines creates squares, 
rectangles, or diamonds.

• Sew the first set of lines as for channel quilting. Mark the centerline for the second set of
lines; stitch as for channel quilting, positioning the Walking Foot guide as desired.

OUTLINE QUILTING
Give definition to pieced, printed, or appliquéd motifs by
adding a machine-fed or freemotion stitched outline.

• Machine-Fed – Use Walking Foot #50 and a straight or
handlook quilting stitch. For a closely spaced outline, adjust needle position to one side
and use edge of foot as a guide. For larger spacing, attach a seam guide. Stitch around
shapes as desired. 

• Freemotion – Use Freemotion Quilting Foot #29/29C, a straight stitch, and lowered feed
dog. Stitch around or inside shapes as desired, using outer edge of foot as a guide.

ECHO QUILTING
Similar to outline quilting,
but with multiple lines
creating an effect like that
made by a stone thrown
into a pond.

• Stitch first ring as for
Outline Quilting. Repeat
as desired.

FREEMOTION STITCHING
Freedom to create and place stitches where you want them!

• Drop feed dog and select a straight stitch. Insert a Quilting needle and thread needle
and bobbin with 50-weight cotton thread. Attach Freemotion Quilting Foot #29/29C.

• Prepare a small practice piece, about 18” x 18”, with top, batting, and backing. Once
you’ve mastered the technique, you can move on to larger pieces.

• Place the practice piece under presser foot. Lower the foot; even though it doesn’t
touch the fabric, the foot must be lowered to engage the tension discs.

• Sew one stitch, stopping with needle up. Pull needle thread to bring up the bobbin
thread. Take a few stitches in nearly – but not quite – the same place to secure stitching.
Clip tails.

• Before continuing, set a timer for 15 minutes and make sure you won’t be disturbed.
This will help keep you from wondering how long you’ve been practicing.

• Place hands on either side of the needle area as a “hoop”. Begin stitching, running the
machine at a moderate speed while moving your hands in a smooth, controlled manner
to form even, consistent stitches.

• Practice making simple, repetitive shapes, and then try your hand at the freemotion
quilting techniques described on the following page.
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CONTINUOUS LINE QUILTING
The long, unbroken lines of these intricate patterns are easily stitched by machine.

• Use straight stitch with lowered feed dog, and Freemotion Quilting Foot #29/29C
or Freemotion Embroidery Foot #24. Mark stitching lines using a temporary
method: chalk, wash-away marker, or other technique. Stitch on marked lines.

STIPPLE QUILTING
While lines seem to be randomly placed, there are a few rules, which ensure the
uniformity of the stitched shapes:

• Lines of stitching should be evenly spaced, about 1/4” apart

• Curves and loops should be of the same scale the size of which depends on the
area being stippled.

• Traditionally, stipple stitches resemble puzzle pieces - smooth even curves with
lines that do not intersect.

This can be tricky! Keep a small pad and pencil in your pocket or purse for prac-
ticing “stipple-doodling” in odd moments. Another way to practice stippling is with
a pencil and coloring books that have a motif in the center of the page only;
sewing on coloring book pages with no thread is also great practice!

“DOODLE” QUILTING
Think of this
technique as
controlled 
doodling!
Squiggles,
swirls, leaves,
thunderbolts,
hearts…any
and all shapes
and figures are
acceptable.

THE BERNINA® STITCH REGULATOR
Now freemotion stitching is easier than ever!

The new BERNINA® Stitch Regulator (BSR) with two
stitching modes, is standard for the aurora 440QE. It
offers regulated, even stitches, no matter the speed
or direction in which the fabric is moved. A “beep”
signals if the fabric is moved too quickly.

When using the new BERNINA® Stitch Regulator, the
BSR adjusts the needle movement to coordinate with
the movement of the fabric, aiding in the production
of consistent, regular stitches. All you have to do is
lower the feed dog and move the fabric!

The BSR operates with a camera-like sensor that reads
the fabric through an optical lens in the foot. The sen-
sors “looks” at the fabric, senses the movement, and calculates the distance – then directs the needle to stitch depending
on the selected stitch length settings. For example, if the stitch length is set at 2.5mm, the sensor calculates the distance
and stitch frequency, repeating stitches with regular precision regardless of the speed at which the fabric is moved.

The BSR works on fabrics with a variety of surface textures – including velvet, lamé, fleece, corduroy, and denim –
making it perfect for a wide range of quilting applications.
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The BERNINA® Stitch Regulator is constructed with the famous BERNINA® hopper mechanism – as are all BERNINA®

freemotion feet – ensuring precision stitching. When the needle enters the fabric, the freemotion sole moves upward; as the
needle leaves the fabric, the sole is lowered so that the fabric is not raised with the needle, thus preventing flagging and
uneven stitches.
Three soles are included with the BSR to handle all your freemotion stitching needs:

• Closed Metal Sole – Similar to Darning Foot #9, with the needle centered and visible.

• Open Metal Sole – Like Freemotion Embroidery Foot #24, this sole gives an optimal view of the needle.

• Transparent Sole – Glides easily over all fabrics – including layers of batting – in every direction. Marked with cross-hairs
for easy visualization of the needle position; great for outline and echo quilting!

QUILTING WITH MACHINE EMBROIDERY
With the ever-growing popularity of the home embroidery machine, it was
inevitable that machine embroidered techniques would be added to the list
of stitching methods used to create quilts. Whether one selects from the
nearly infinite number of embroidery designs available for purchase, or  dig-
itizes her own designs using a computer and embroidery software, there are
many ways to incorporate embroidery into quilt designs. Embroidered motifs
can create the focal point of each block and set the tone or theme for the
quilt. They can embellish blocks, or be used as quilting to secure the layers
together. The “in-the-hoop” quilting method described here is appropriate
for all skill levels and eliminates many of the obstacles that may occur when
blending quilting and embroidery techniques. 

Quilting stitches secure the layers of the quilt together (top, batting, and backing); outline motifs are often used to accent
open areas of the quilt. The machine embroidered decorative quilting is stitched through the top of the quilt and batting
only. This eliminates any thread tension issues on the back and also takes care of any aesthetic issues with thread tie-offs,
as they are hidden when the backing fabric is added to the quilt. Leaving the tension tight on the bottom causes the outline
designs to “puff up” a bit more than if the tension were balanced. 

Once the decorative quilting is completed, the backing is spray-basted in place. “Utility” quilting stitches (such as channel,
ditch, and grid quilting) are sewn through all three layers as described on the previous pages. This visually balances the
decorative quilting and adds texture to the back of the quilt.

Hooping and Stabilizing
For the best results when embroidering, the project must be hooped and stabilized appropriately. Outline quilt designs are
very light, making water-soluble stabilizer the perfect choice. The water-soluble stabilizer rinses completely away, leaving
the quilt soft and stabilizer free. 

To hoop the quilt, the screw on the outer ring is loosened significantly, the quilt is placed over the outer ring, then the inner
ring is gently pushed into the outer ring. Forcing the inner ring may distort the seam lines on the quilt. Tip: Use a quilt bast-
ing spray to temporarily bond all layers of the quilt together. This eliminates any shifting of the layers during the embroidery
process.

As an alternative for small designs, a layer of water-soluble stabilizer is hooped, sprayed with temporary adhesive, then the
quilt is affixed to the hoop. For large or intricate designs, hooping is the best option. When using the adhesive method, the
quilt is basted to the hooped stabilizer for additional stability. The basting stitches are removed when the quilting is complete.
Tip: Create a basting file using your embroidery software program. Simply digitize an outline around the inside perimeter of
your hoop; use a long stitch length for ease in removal. (Hoop files for all BERNINA® embroidery machines may be down-
loaded from www.berninausa.com > What’s New > Free Downloads.)

Design Placement
Accurate design placement is essential to the success of the finished project. Design templates may be copied or printed,
then trimmed to fit the quilt block. Multiple designs may be combined for quilt blocks larger than the machine’s maximum
hoop size, then pinned or adhered to the quilt with double-sided tape. Tip: Print templates on transparencies for maximum
visibility. The plastic hoop template is used to keep the project aligned correctly in the hoop. The Check function of the
machine is used to adjust the design position if necessary. Tip: Use quilt block seam lines to help position design
templates and as reference lines for the hoop template.
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CONTINUING EDUCATION
Take classes as often as possible and indulge in reference books for your quilting library. If you have an
opportunity to attend a quilt show, study the quilts on display. Make note of the things that make the quilts
successful. Ask questions of other quilters, quilt teachers, and staff at your local quilt shop. Remember,
quilting is a leisure time activity. Experiment with techniques until you find the ones that give you the best
results with the least amount of frustration and the most pleasure and satisfaction.

Take a tip from some nationally known quilting experts, award winners, authors and designers:

“My best tip for improving the overall appearance of the finished quilt is to hand-baste it with water-soluble
thread. I further baste by machine to anchor the straight lines in the top by stitching-in-the-ditch with
water-soluble thread.” Ricky Tims 

“If I only could tell you one thing about machine quilting it would be that you must be comfortably in control
of all three layers of the quilt sandwich, and the best way to accomplish this is to use a Flynn Multi-Frame
when you machine quilt." John Flynn

“Be sure you are sitting high enough to be comfortable while you are quilting. Think about elementary school
penmanship, fluid motions, and control.” Holice Turnbow

“I quilt using the “fluff and stuff” method rather than rolling the quilt into a tight roll. The quilt needs freedom to
move under the needle.” Paula Reid

“Never make a quilt to match an ugly carpet.” and “A quilt won’t ever be finished if you don’t work on it.”
Marianne Fons

“Don’t forget to breathe. Relax while quilting – remember this is supposed to be fun.” Laura Cater-Woods

“Needles lose their points quickly and are not the place to pinch pennies. When it comes to needles, if in
doubt, throw it away.” Sharon Schamber.
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BY JENNIFER GIGAS

The Artwork Roadmap
Refer to owner’s manual Chapters 11-12
The most efficient way to get to where you are going is by following a
well thought out plan. The better the map, the fewer detours you will have
to make. Answering the following questions is the first step in planning
your digitizing path.

• What am I starting with – clip art, fabric, a drawing?

• What do I envision as the final result?

• Where will I be using the finished design? 

• How large does it need to be?

• On what kind of fabric will it be stitched?

• What tools should I use to get there?

What am I Starting With?
Note: Be sure to follow all copyright rules and regulations
when selecting your artwork. If in doubt, ask! 

As a general rule, the cleaner the artwork, the
easier it will be to digitize. Eliminate

excessive detailing that will not translate
well into embroidery stitches. Place a

sheet of tracing paper over complex
artwork and trace only the elements
needed. When working with artwork
from fabric, you may wish to
photocopy the artwork before tracing.
If unsure about the amount of
detailing to remove, spend some

time looking at professionally
digitized designs.

With visions of original embroidery designs 
dancing through your imagination, you open 

your Designer Plus embroidery software, 
skim through the manual, and…now what? 

The following practical guidelines will 
start you on the path to fulfilling 

your embroidery dreams!

Do your Homework!

Before starting to digitize designs, it is

highly recommended that you read

through the Owner’s Manual included with

the BERNINA® Embroidery Software and

attend the software guide classes offered

at your local BERNINA® dealership. These

will provide you with the foundation

necessary to begin your journey into the

world of digitizing.

Spend time watching how professionally

digitized designs are stitched. This can

be accomplished by actually stitching

designs or by importing them into the

embroidery software and activating the

Slow Redraw function. Take note of the

path of the needle, the amount of detail

included, the underlay used and how

outlines are handled.
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Regardless of the origin of the artwork (hand drawn or clip art for example), a
graphic file needs to be created for use by the embroidery software. Scan

the artwork and save in a format recognized by the embroidery software.
(Note: For a complete listing of supported file formats, refer to page 418 of
the User’s Manual.) The better the quality of the original artwork, the better
the image will be. It is not necessary to scan the artwork with a high
resolution. High resolution files are very large, and may tie up valuable system
resources, resulting in a slowdown in software response. (Note: For a listing of
resolution settings, refer to page 88 of the Owner’s Manual.)

Graphics may be scanned directly into the Designer Plus software.

• Select the Picture Tab.

• Select the Scan Picture Icon.

o Preview the image in the scanning program window.

o Select the area to be scanned.

o Scan and save the graphic in a compatible format in the My Designs folder.

Note: Graphics scanned this way must be saved separately from the design file or they will
be lost when you close the design.

Graphics stored on your computer, on a CD, or on other media may be imported into the Designer Plus
software.

• Select the Picture Tab.

• Select the Load Picture icon.
o From the Look In box, select the appropriate drive.

o Be sure the correct Files of Type has been selected.

o Locate the image you wish to work with; click Open.

What is the Final Result?
Take a look at the graphic image on the screen. What kind of stitching will be most appropriate for each area of the image?
In addition to 20 step fills, there are 250 fancy fills, craft fills, pattern fills and a satin fill. Refer to the Reference Files
(C:/MyDesigns/ Reference) for a look at some of the fill types. You may wish to sew out the reference files to use when
selecting stitch types. Will any of the areas include outlines? What kind of outline style would be most effective?

What colors will you be using? Setting up a custom thread chart will provide a more realistic view of the finished design.
Printing out the design template with the correct thread colors listed makes embroidery time more efficient. Custom
charts may be set with the thread brands and colors to be used in the design. (Note: For detailed information on
Thread Charts, refer to page 75 of the Owner’s Manual.) When planning your design coloration, use pencils or markers
to color copies of the artwork.

In what order should the design elements sew out? Objects will sew out in the order they were
created. Keep this in mind when planning your digitizing sequence. As a general rule, large areas and
background areas are stitched first. Details and outlines are stitched last. Stitching sequence may be
edited once the design has been finished; however, it
is more time efficient to simply plan the design path,
especially with more detailed designs. Using a copy of
the graphic, number the elements in the order they
should be created. Use this as a guideline during the
digitizing process.

How large will the finished design be? Although it is
possible to adjust the size of any design created in
the BERNINA® Embroidery Software, the amount of
detailing will vary according the finished size of the
design. 
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What kind of fabric will the design be embroidered on? Settings
for a variety of fabrics may be adjusted automatically.

• Select the entire design.

• Settings>Fabric Settings. 

o Select the appropriate fabric type. Click OK.

What Tools Will I Use to Create the Design?
Designer Plus Embroidery software provides both manual and fully automatic digitizing tools. Tool selection is based prima-

rily upon the complexity of the artwork. Combine the best of what each tool has to offer to complete your embroidery design
most efficiently.

• Auto-Digitizer: Use the Auto-Digitizer to digitize an entire design with one click. This tool is best used for full-color graphics
with minimal detailing. Objects that have been auto-digitized may be edited to adjust stitch angle, stitch type and color. Keep
in mind that the software may convert some outlines to filled areas, depending on the width of the lines.

• Magic Wand: The Magic Wand is used to automatically digitize individual areas of a graphic. This tool is best used for black
and white graphics or to quickly generate individual areas of a more complex piece of artwork. Objects that have been created
with the Magic Wand may be edited to adjust stitch angle, stitch type and color. Tip: Remember to process the artwork using
the Artwork Preparation tools prior to using automatic digitizing tools.

• Closed Curve Tool: The Closed Curve tool is used to manually create a closed area or solid shape. The area may be digitized
with an outline and/or fill stitches. The closed curve tool is best used for the more complicated areas of a graphic or areas that
that you wish to alter from the original graphic. 

• Open Curve Tool: The Open Curve Tool is used to manually create an open outline shape using any of the outline stitch types.
The open curve tool is best used for the more complicated areas of a graphic or areas that that you wish to alter from the
original graphic.

When using automatic digitizing tools, don’t forget to activate Automatic Underlay and set the Pull Compensation to 0.4.

Digitizing the Design
Following the map made during the planning process, create each area of the design.
Remember to save your work often – after every major change. You may wish to Save As rather
than simply Save. By using Save As, the previous file is still available if you wish to go back
and begin working again from an earlier point.

Take advantage of the Slow Redraw feature to preview the sewing sequence of the
design. Use Slow Redraw throughout the digitizing process to check your work.

It is easier to make changes as you work than to go back and rework a
complete design.

Special thanks to Susan Fears for providing the original framework for
this article.
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THE ART OF APPLIQUÉ

Appliquéd embellishments have been
used by generations of stitchers all

over the world to add figurative
elements to garments, linens,
quilts, and much more. From
the intricate Baltimore Album
Quilts of the southeastern
United States to the colorful
Molas produced by the Cuna
Indians off the coast of
Panama to the symmetrical
design of Hawaiian Quilts,
appliqué has been used as a

decorative technique to add
color, texture, and ornamenta-

tion to projects of all types.
Because you are not limited to one

method, appliqué becomes a palette
of techniques from which to choose

when planning a stitching adventure.

If you’ve never stitched appliqué before, the follow-
ing pages will introduce you to a variety of techniques,
supplies, and tools. Those experienced in the art of
appliqué will gain insight into new methods, and perhaps
learn ways to improve their skills or be inspired to try
something new. The pages that follow include information
on basic appliqué techniques, tools and supplies, and
additional appliqué embellishment options. Use those that
appeal to you, and explore the art of appliqué!

PATTERN PREPARATION

When using appliqué patterns, you will usually trace or
re-draw them to create pieces that can be cut from differ-
ent fabrics to “build” your finished picture. Use the follow-
ing tips to successfully trace and cut your appliqué shapes.

Which Way Do I Go?

To avoid creating an appliqué which is a mirror image of
the original pattern, trace the appliqué pieces from the
wrong side IF: 
• You are tracing onto the paper side of fusible web.

• The pattern piece is to be positioned on the wrong side

of appliqué fabric for cutting.

• The pattern’s creator hasn’t already reversed the image
for you; read the pattern instruction sheet for additional
tracing information.

• You are using a reverse or faced appliqué method.

Draw your pattern using the Nifty Notions®

Pentel Pencil and Lead (#7843) – makes a very
fine line and easily washes off fabric. 

Which Side Am I On?

The width of a line doesn’t seem very critical, but it can
make a difference in the size of your appliqué pieces. In
general, appliqué pieces with turned-under edges should
be traced at the outer edge of the pattern line, while
raw-edged shapes should be traced along the inner edge. 

• Satin Stitch Appliqué – draw inside the line
• Blindstitch (Hand-Look) – draw outside the line
• Blanket Stitch Appliqué – draw outside the line
• Machine Embroidered Appliqué – draw outside the line
• Reverse/Upside Down Appliqué – draw outside the line

Which One’s On Top? 

When pattern pieces share a stitch-down line, add a 1/4”
seam to the piece lying underneath, extending the shape
beyond the shared seam line. Frequently, the pattern
creator will have already done this for you, indicating the
edge of the seam allowance with a dotted line. Read the
pattern instruction sheet for additional tracing
information.

Invisible appliqué pieces will need 1/4” seam allowances
added to all edges if the pattern’s creator hasn’t already
done this for you. Read the pattern instruction
sheet for additional tracing information.

When cutting a printed design from a
fabric panel, add 1/8” to the outer
edges. This will preserve the outer
edges of the design and allow the
satin stitching to frame the design
without intruding into the “picture.”
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ap•pli•qué

n. – a method
of ornamentation
in which shapes of
one material are
applied to another
to create a picture
or design. v. – to
appliqué is to stitch
shapes of one
fabric to a base
or background
fabric.

HINT:
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FABRICS

Fabrics of many different types, weights and fibers may
be used for the various appliqué techniques, but keep in
mind that 100% cotton fabrics are the best choice to use
for learning the techniques. The appliqué fabrics should be
lighter in weight than the background fabric to which they
are being applied, and should be pre-shrunk as necessary.

STABILIZERS

Used to support the stitch formation of
appliqué, stabilizers are necessary

to prevent tunneling of the
fabric. Choose the lightest

weight available even
if it requires using
multiple layers; sepa-

rate layers before tearing
away. Always test the com-

bination of fabric and stabilizer for each project.

Removable – tear stabilizer away upon completion of all
stitching; the stabilizer under the stitching will remain in
place to support the stitches 

• OESD Light Weight Tear-Away– lightest weight available;
use two layers

• OESD Ultra Clean & Tear – medium weight; leaves a super
clean edge after tearing; softens with repeated washings

• OESD Medium Weight Tear-Away – black for use with
dark-colored project fabrics

• OESD Smooth Touch Tear-Away – medium weight;
softest against the skin 

Water-Soluble – for washable projects; all of the stabilizer
washes out, leaving no supporting stabilizer under the
appliqué stitches

• OESD Aqua Mesh Wash Away – easiest of the available
wash-away products to wash out; soft against the skin

• OESD Aqua Film Backing – rinse to remove completely

• OESD BadgeMaster – heavier than Aqua Film; soak to
remove completely

Permanent – cut away excess stabilizer after stitching
leaving stabilizer to support the appliqué stitching

• OESD Stabil-Stick Cut-Away – medium weight; less
needle “gum-up” than other sticky-backed products;
especially useful with knit and stretch fabrics

• OESD Poly Mesh Cut-Away – medium weight; soft to
the skin; minimizes shadowing of stabilizer through
light-colored garments; excellent for knitted fabrics;
perforated sheets; available in white, black, and beige

Fusible – usually iron-on product – remains around and
under the appliqué to support both the appliqué and its
stitches – especially useful on large appliqués for table
linens

• OESD Fusible Poly Mesh – soft but stable

• HTC Whisper Weft™ – adds support while maintaining
fabric’s flexibility; especially good for wearable art projects

• HTC Fusi-Knit™ – fusible tricot interfacing with cross-
wise stretch; excellent for soft fabrics

ADHESIVES

Several methods of appliqué use fusible products to
adhere the appliqué shapes to the background fabric.
There are several types available for use in a variety of
appliqué situations:

Permanent – remains in the project after washing

• Fine Fuse from Quilters’ Resource – for soft and light-
weight fabric; pure white 

• Steam-A-Seam2® – double-sided, stick-on fusible web;
soft; will not “gum-up” the needle; position and fuse the
pieces together before placing them on the project

• 606 Spray And Fix – for tiny pieces; spray the fabric,
then cut the appliqué shapes

Temporary – dissipates after 12 to 24 hours

• 505 Temporary Spray Adhesive – fabric-to-fabric
• 202 Temporary Spray Adhesive – paper-to-paper or

paper-to-fabric

Use a non-stick fusing sheet to protect your
pressing surface. Position and fuse on top of
the fusing sheet; place a second sheet on top
to protect the sole of the iron.

NEEDLE THREAD

The highest quality thread is necessary for
a successful appliqué project. It is also
very important to use the correct
type of thread for the select-
ed technique. For the
majority of appliqué
techniques, machine
embroidery threads will be used.
Most machine embroidery threads are 2 ply and softly
twisted; different from “construction” quality threads,
which are usually 3 ply because they need to be strong
enough to hold a seam together. Machine embroidery
threads, on the other hand, are usually decorative, with a
soft, “filled-in” appearance. They are available in a wide
variety of fiber contents including cotton, rayon and
polyester; variations in fiber content give different sewn
appearances when applied, so experiment and have fun!

Ask yourself these questions before selecting a thread:
Will the project be washed repeatedly? Will the stitching
be subject to friction? Will it be bleached or soaked in
stain-removing products, requiring the thread to be color-
fast? Do I want a soft matte finish or a shiny look to the
thread? Your answers will help you select the appropriate
threads from the list below. 

Polyester – tough; durable; soft enough not to cut the
fabric; colorfast

• OESD Isacord Embroidery Thread
• Mettler Polysheen Embroidery Thread
• YLI Variations – variegated embroidery thread 
• Superior Rainbows™ (40 wt) – variegated
• Superior Highlights™ (40 wt) – solid colors
• Superior Nature Colors™ (40 wt) – solid colors
• Superior Living Colors™ (40 wt) – solid colors

Acrylic – colorfast; more durable than rayon, but not as
durable as polyester; shinier than polyester; rough to the
touch; adds dimensional effect to stitching

• YLI Ultrasheen – acrylic embroidery thread 

TIP:
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Cotton – more durable than rayon, but not as durable as
polyester

• Mettler Fine Embroidery Thread (60 weight)
• Cotton Embroidery Thread (30 weight)
• YLI Soft Touch (60 weight)
• YLI Colours (30 weight) – lovely variegated colors
• Oliver Twist Hand-Dyed Embroidery Thread (50 weight)
• Oliver Twist Over the Top (16 weight)
• DMC Cotton Machine Embroidery Thread
• Superior Perfect Quilter (17 weight)
• Superior King Tut Quilting Thread™ (40 weight)

Metallic – two main categories: 
1) metallic fibers wrapped around a polyester core, and 2)
narrow strips of metallized polymer film

• Yenmet – available in Metallic, Pearlessence, and 
Twilight varieties

• YLI Reflections
• YLI Fine Metallic
• YLI Kaleidescope Holographic Thread
• YLI Brilliance Metallic Glow-in-the-Dark Thread
• Sulky Metallic
• Sulky Sliver
• Superior Glitter™

Rayon – soft; delicate with a high sheen
• Sulky 40 weight rayon embroidery thread
• Sulky 30 weight rayon embroidery thread slightly

heavier than 40 weight

Other Threads – miscellaneous threads for special effects
• YLI Monet – 40% wool / 60% acrylic; use with a 

Topstitching needle
• YLI Jeanstitch –solid and variegated colors; suitable 

for blanket stitch appliqué; use Topstitching needle 
• YLI #100 Silk Thread
• YLI Candlelight –metallic yarn used for couching 

BOBBIN THREAD

The selection of bobbin thread is also very important. In
general, the bobbin thread is a lighter weight than the
needle thread, and will usually be selected to match the
background fabric color. Don’t use inexpensive “basting”
thread, as it will generate a large amount of lint in the
bobbin/hook area.
• OESD Bobbin Thread – lightweight polyester; available 

in black and white
• Mettler Fine Embroidery Thread (60 weight) – soft 

against skin; available in many colors

A PERFECT STITCH

Thread tension is an important element when doing
appliqué work. The needle and bobbin threads must work
together to create beautiful stitches. If using differing
weights in the needle and bobbin, adjustments to the
tension must be made – there should be no bobbin thread
showing on the top of the fabric. To achieve this, try the
following:

• Loosen the upper thread tension: 
- 40 weight threads – loosen slightly
- 30 weight threads – loosen a little more
- Metallic thread – loosen much more

• Thread the stitch finger of the bobbincase (CB bobbins only)

APPLIQUÉ PRESSER FEET 

There are several presser feet suitable for appliqué. Each one
has specific uses and can help you place the stitching exactly
where it needs to be. Move the needle position to the right (if
available), and use the inside toe of the presser foot to guide
the stitching along the edge of the appliqué.

Embroidery Foot (BERNINA #6) – has a deep tapered thread
escape on the sole of the foot

Open Embroidery Foot (BERNINA #20/20C) – has no bar connect-
ing the toes in front of the needle; provides excellent visibility

Clear Embroidery Foot (BERNINA #39) – has a clear plastic
sole; good visibility and excellent fabric control 

Clear Appliqué Foot (BERNINA #23) – has a 3mm thread
escape on the sole of the foot; perfect for narrow and corded
appliqué
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SATIN STITCH APPLIQUÉ

Traditional in style, this method uses
a zigzag stitch with a short length,

completely covering the raw edge
of the appliqué shape.

Settings & Supplies

STITCH: Zigzag Stitch

STITCH LENGTH: 0.2-0.5
depending on weight of
thread

STITCH WIDTH: As desired

NEEDLE POSITION: Center or
far right

PRESSER FOOT: Embroidery
Foot #6, Open Embroidery Foot

#20/20C. Clear Appliqué Foot #23,
Clear Embroidery Foot #39

THREAD: Needle – Decorative machine
embroidery threads – cotton or rayon; Bobbin –

60/2 Mettler embroidery thread

NEEDLE: Choose the needle based on the fabric and type
and size of thread selected – Machine Embroidery,
Metallica, Metafil, Topstitching

TENSION: Generally, the tension for the upper thread is
reduced (lower number). This allows for the top thread to
be pulled to the underside of the background fabric as well
as not making frequent bobbin thread changes necessary.

Technique

Fuse paper-backed fusible web to the wrong side of
appliqué shapes. Draw shapes on the paper; cut out. Peel
paper from the shapes and position them on the back-
ground fabric. Fuse in place. Stitch around the shapes,
covering the raw edges with the satin stitching. The
majority of the stitch should be on the appliqué shape with
the needle penetrating the background fabric just outside
the shape; threads should be perpendicular to edge of the
appliqué fabric, laying side-by-side but not overlapping. 

MITERED CORNERS: Sew
satin stitch to corner ending
with needle down in the
fabric; pivot. Reduce stitch
width to 0.5mm; take two
stitches. Increase stitch
width to 1mm.; take two
stitches. Repeat the process
of increasing stitch width
and taking a couple of
stitches until you are back to the original stitch width.
This covers the corner entirely with stitches, giving the
look of a mitered corner.

SMOOTH CURVES: Stop and pivot
slightly on a frequent basis for smooth
curves.

Inside – Pivot with the need in the fab-
ric at the inside edge of the appliqué. 

Outside – Pivot
with needle in

the fabric at
the outside
edge of the
appliqué. 

SECURING: Overlap the ending
with the beginning stitches and
sew several straight stitches on the
inside of the appliqué stitches.

Appliqué
techniques have
been extremely pop-
ular throughout the
years whether stitched
using traditional sewing
machine methods or with
hand sewing methods. While
there are a variety of applica-
tions and methods for 
applying fabric shapes to a
fabric base, the end result 
is usually the same – a 
wonderful fabric picture!
Beautiful fabrics, fanciful
threads, and creative
stitches become the
artist’s tools for
creation.
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• Place Tear Away stabilizer on the wrong side of
the area to which the appliqué will be stitched.
This stabilizer will be removed after the stitching
is complete.

• Always test using the project fabric to determine
the settings needed for the perfect satin stitch.

• Thicker threads (30 weight cotton or rayon)
require a longer stitch length.

• Finer threads (60 weight cotton or 40 weight
rayon) require a shorter stitch length.

Variation: Corded Appliqué

Similar to satin stitch appliqué, the stitch is formed over a
cord to give it a defined raised look; an excellent way to
reinforce the edges of the appliqué shape. Use the same
general settings as satin stitch appliqué with Embroidery
Foot #6 or Clear Embroidery Foot #39. Place a narrow
cord such as perle cotton or Pearl Crown Rayon through the
hole in the center of the foot. Stitch around the shapes,
covering the raw edges with the cord and satin stitching.

BLANKET STITCH APPLIQUÉ

This open stitch is used to give a homespun or primitive
look to appliqué; shapes should be fused or bonded in
place before stitching them to the background.

Settings & Supplies 

STITCH: Blanket
Stitch 

STITCH LENGTH: A
longer stitch length
(4mm-5mm) than
the preprogrammed
setting  

STITCH WIDTH: A
longer stitch width
(4mm-5mm) than
the preprogrammed
setting 

NEEDLE POSITION:
Center or  far right
(depends on foot
selection)

PRESSER FOOT:
Edgestitch Foot
#10/10C or Open Embroidery Foot #20/20C

THREAD: Needle – Heavy weight threads such as 30/2
Cotton or Rayon, Jeans Stitch, Cordonnet; Bobbin – 50/3
Mettler Silk-finish

NEEDLE: Larger eye needle-90/14 machine embroidery or
80/12 – 90/14 Topstitching Needle

TENSION: Tension needs to be adjusted to achieve a
balanced stitch. The adjustment will be determined based
on whether the heavy weight thread is used only through 
the needle or for both needle and bobbin.

Technique:

Fuse paper-backed fusible web to the wrong side of appliqué
shapes. Draw shapes on the paper; cut out. Peel paper from
the shapes and position them on the background fabric.
Fuse in place. Stitch around the shapes with the the straight
part of the stitch laying along and covering the raw fabric

edge. The sideways part of the stitch (“finger”) decorates
the appliqué fabric and secures it to the project

PERFECT CORNERS:
Sew perfect corners by
using the Pattern Begin
function, or accessing the
stitch again. Sew to corner
aligning the “finger” of the
stitch with the corner of
the fabric. Touch Pattern
Begin. Pivot fabric 45°.
Take one stitch only; touch
Pattern Begin. Pivot fabric

45°; continue sewing to complete the appliqué.

• Place Tear Away stabilizer on the wrong side of the
area to which the appliqué will be stitched. This
stabilizer will be removed after the stitching is
complete.

• Stitch length = distance between the blanket stitches. 

• Stitch width = the length of the blanket stitch “finger”.

• Engage mirror image if needed.

• All pivoting is with the needle on the outside
edge of the fabric piece.

INVISIBLE APPLIQUÉ

Simulating hand-sewn stitching, this method requires the
appliqué shape to have finished edges, which are then
stitched to the background using a blindstitch and
“invisible” thread.

Settings &

Supplies

STITCH: Blindstitch
(Blind Hem Stitch)

STITCH LENGTH:
1mm or less
depending on fabric

STITCH WIDTH:
0.8-1mm (catch
about 2 threads of
fabric only)

NEEDLE POSITION:
Center to far right
depending on foot
selection

PRESSER FOOT: Embroidery Foot #6, Open Embroidery Foot
#20/20C, Clear Embroidery Foot #39, Edgestitch Foot #10

THREAD: Needle – Monofilament thread (clear or smoke);
Bobbin – 60/2 Mettler machine embroidery cotton thread

NEEDLE: Size 60/8 or 70/10 sharp needle; needle holes
should not be visible in finished product.

TENSION: Reduced (lower number)

Technique

Create faced applique shapes using the method below:
Trace desired shape onto Aqua Film with an indelible
marker. Pin Aqua Film to right side of appliqué fabric.

TIPS:

TIPS:
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Take care to keep the Aqua Film right side up.

Writing the letter P on the Aqua Film will make
it easier to keep the pattern piece oriented
correctly.

Attach Non-Stick Open Embroidery Foot #56 to machine.
Thread needle and insert bobbin with sewing thread. Sew
on traced lines around appliqué with a straight stitch. Trim
around the outside of appliqué motif, leaving a 1/4” seam
allowance; cut slit in center of Aqua Film. Clip curves and
points if applicable. Turn right side out; smooth curves and
push out corners. Place right side up on ironing surface and
press with a warm iron. The Aqua Film will “draw up” and
pull the stitching to the wrong side. Remove excess Aqua
Film from center back of appliqué, leaving the sides
“glued” down. Pin or baste with temporary spray adhesive
to hold the appliqué in place on background fabric.

Set the machine for a blindstitch using the settings on the
previous page. Sew slowly around the finished edges of
appliqué shapes, using the Free Hand Sewing system
(knee-activated presser foot lifter) to maneuver curves
and corners. The straight part of the stitch should fall just
outside the appliqué shape with the wide part barely
“biting” into the shape to secure it invisibly.

Forcing a “bite” is essential on corners or
edges that need an extra stitch. Use Pattern
Begin to force a “bite”.

• Sew a test to see if stabilizer is necessary. If
needed, place Tear Away stabilizer on the
wrong side of the area to which the appliqué
will be stitched. This stabilizer will be removed
after the stitching is complete.

• Appliqué pieces are placed next to each other
with little or no overlap.

• Pivot with the needle on the outer edges of the
appliqué shapes.

DIMENSIONAL APPLIQUÉ

Freestanding appliqué shapes that are “tacked” to the
surface of the fabric, giving a 3-D effect to the design.

Settings &

Supplies

STITCH:
Zigzag
Stitch 

STITCH
LENGTH:
Varies

STITCH
WIDTH:
Varies

NEEDLE
POSITION:
As needed

PRESSER FOOT: Embroidery Foot #6, Open Embroidery
Foot #20/20C, Clear Appliqué Foot #23, Clear Embroidery
Foot #39

THREAD: Needle – Decorative machine embroidery
threads – cotton or rayon; Bobbin – 60/2 or 50/3 cotton

NEEDLE: Choose the needle based on the type and size of
thread selected: Machine Embroidery, Metallica, Metafil,
Topstitching

TENSION: Generally, the tension for the upper thread is
reduced (lower number). This allows for the top thread to
be pulled to the underside of the background fabric as
well as not making frequent bobbin thread changes
necessary.

Technique

The best fabric for this technique is a stable mid-weight
fabric. It should be double-sided such as Ultrasuede® or
be two pieces fused together with right sides out.

Using a water-soluble marker, draw the various pieces of
the appliqué onto the fabric. The best designs for this type
of appliqué have multiple parts such a flower that has
separate petals instead of one large bloom.

Cut out each drawn shape. Optional: For fabrics that
ravel, finish each section of the appliqué with a satin
stitched, corded satin stitch or wired satin stitch edge
finish.

Secure the appliqué shapes onto the background fabric
using a straight stitch, bartack, or decorative stitches.
Add creases, tucks, and folds to the shapes before
attaching to add to the dimensional effect. Optional: Add
beads, charms or other embellishments as desired.

• Place Tear Away stabilizer on the wrong side of
the area to which the appliqué will be stitched.
This stabilizer will be removed after stitching is
complete.

• Always test using the project fabric to
determine the settings needed for the perfect
satin stitch.

EMBROIDERY MACHINE APPLIQUÉ

Using the embroidery machine to appliqué is a way of
achieving a large area of color and/or pattern in an
embroidery design without using a large number of
stitches.

TIPS:

TIPS:

TIP:

NOTE:
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Settings & Supplies

PRESSER FOOT: Embroidery Foot as required by machine.

THREAD: Needle – Decorative machine embroidery threads –
cotton or rayon; Bobbin – 60/2 or 50/3 cotton Silk-finish

NEEDLE: Choose the needle based on the type and size of
thread selected: Machine Embroidery, Metallica, Metafil,
Topstitching

TENSION: This is automatic on many embroidery
machines. Another option for adjusting the tension: If the
bobbin has a CB hook system and/or a hole in the “finger”
of the bobbin case, thread the finger after inserting the
bobbin into the case. 

Technique

There are four basic steps to successfully stitching
embroidered appliqués. These
steps are created when the
design is digitized. BERNINA®

V4 Embroidery Software has an
Auto Appliqué feature that auto-
matically digitizes a design as
an appliqué with just one click.

1. PLACEMENT LINES: This first
line of single outline stitching
indicates the position and size
of the appliquéd shape. The fab-
ric “patch” must completely
cover this area for the appliqué
to be “filled” with fabric.

2. STRAIGHT SECURING
STITCHES—METHOD ONE: This
second line of outline stitching
holds the appliqué “patch” in
place. After stitching, the hoop
is carefully removed from the
machine/module and the excess
fabric trimmed from outside the
stitching lines.

3. ZIGZAG SECURING
STITCHES—METHOD ONE: This
line of zigzag stitching acts as a
“filler” and adds dimension to
subsequent satin stitching. Note:
Appliqué shapes outlined with
blanket stitching will not have this
step. METHOD TWO: Holds the
appliqué “patch” in place. After
stitching, the hoop is carefully
removed from the machine/module
and the excess  fabric trimmed
from outside the stitching lines.

4. COVER STITCH: Usually   a
satin or blanket stitch, this is the
final line of stitching. When com-
plete, the hoop is removed from
the module/machine and excess
stabilizer is removed.

• Suitable for most appliqué designs that can be
sewn in a single hooping.

FACED APPLIQUÉ

The appliqué shapes in this method are placed behind the
fabric, showing through openings in the main fabric.

Settings &

Supplies

For stitch and
settings
information, see
specific techniques
(satin stitch,
blanket stitch,
decorative stitch,
etc.) above. 

Technique

Two methods are
used to create an
opening in the
foreground fabric.
One method is used

for symmetrical motifs and another for asymmetrical
motifs. 

SYMMETRICAL MOTIFS: (Open Embroidery Foot #20/20C)
Fold foreground  fabric right sides together in desired
position of motif. Draw half motif on wrong side using fold as
center of motif. Thread machine with water-soluble basting
thread in needle, regular thread in  bobbin. Sew on drawn
line. Cut inside opening out leaving 1/4” seam allowance. Clip
curves and corners where appropriate. Turn fabric right sides
out (this forces the seam allowance to the wrong side).
Starch and press dry 3 times. Pull fabric apart and you have
an opening with the seams pressed to the wrong side.

ASYMMETRICAL MOTIFS: (Open Embroidery Foot
#20/20C or Freehand Embroidery Foot #24 if stitching
this with the feed dog lowered.) Place a facing fabric right
side down on the foreground fabric. Draw the desired
shape on the wrong side of the facing fabric; sew along
the drawn shape. Cut away the fabric from inside the
shape, leaving 1/4” seam allowance inside the shape. Push
the facing fabric through the opening to the wrong side of
the foreground fabric; press.

ATTACHING THE APPLIQUÉ: After finishing the edges of
the opening, position another fabric behind it, right side
up; pin in place. Stitch around the opening through all
layers using a blanket stitch.

The bite of the stitch should be on the
foreground fabric (the one with the opening),
not on the fabric placed behind the opening.

TIPS:TIP:
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FABRIC SELECTION:

Embellished appliqués can be used
with any fabric, provided that the

fabric is able to withstand
additional stitching and fibers.
Fabrics can be “beefed” up
with the addition of stabilizer
or fusible interfacing. Testing
is the only way to find the
best combination for your
project. As a rule, garment
fabrics usually perform best
with a fusible interfacing;

pre-shrinking adhesive-backed
products is a must. Placing

them in a very warm water bath
for approximately 40 minutes will

do the job. Hang them to dry and then
fuse to the wrong side of the fabric at the

temperature suggested in the manufacturer’s
instructions. Test fused pieces using the method used
to clean the finished project, by either washing or dry
cleaning.

Stabilizers that work well with most applications are
OESD’s Poly Mesh or Aqua Mesh; sometimes a tear
away stabilizer will work as well, depending on the
desired “hand” of the finished project. Both Poly Mesh
and Aqua Mesh will leave the finished project with a
soft feel. The best combination may be both an applied
fusible interfacing and either a cut away or tear away
stabilizer.

CREATING A FINISHED EDGE APPLIQUÉ:

Trace desired shape onto Aqua Film with an indelible
marker. Pin Aqua Film to right side of appliqué fabric.
Take care to keep the Aqua Film right side up. Tip: Writing
the letter P on the Aqua Film will make it easier to keep
the pattern piece oriented correctly.

Attach Non-Stick Zigzag Foot #53 to machine. Thread
needle and insert bobbin with sewing thread. Sew on
traced lines around appliqué with a straight stitch. Cut slit
in center of Aqua Film; trim seam allowance around out-
side of appliqué motif to 1/4”. Clip curves and points if
applicable. Turn right side out. Place right side up on
ironing surface. Press with warm iron. The Aqua Film will
“draw up” and pull the stitching to the wrong side.
Remove excess Aqua Film from center back of appliqué,
leaving the sides “glued” down. Pin appliqué in place on
background fabric.

Take
traditional
appliqué a step
further by adding
decorative stitches
and embellishments.
Embellished
appliqués not only
create a stunning
focal point, but
also enhance your
projects with
a creative
flair.

31

SUPPLIES:

• OESD Aqua Mesh stabilizer

• OESD Aqua Film stabilizer

• Fusible interfacing (pre-shrink before using)

• Indelible marker (such as  a fine point Sharpie™ pen)

• 505 temporary spray adhesive

• Assorted decorative threads and yarns

• Size 90 Sharp sewing machine needle

• Sharp glass head pins

• Bobbin with sewing thread

• Assorted presser feet as desired for decorative stitching
and couching (see page 37).
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DECORATIVE STITCHING

Select desired stitch and sew around appliqué shape with
a decorative thread. The stitch that you choose for this
step should complement the stitches and yarns that you
are adding to the edge of your shape. It must secure the
edge of your shape with sufficient thread to withstand the
wear and tear that your project will have to bear. If you
are creating a wall hanging, lighter stitches can be used.
If the project is one that will be used frequently, then
the edge should be covered with a heavier stitch. The
intricacy of a shape will also influence your stitch
decision. A simple shape such as a circle or square can
be stitched around easily with an intricate stitch that
involves lots of motion. A more detailed or curvilinear
shape, such as a teddy bear that has many nooks and
crannies, would require something simple such as a satin
or blanket stitch.

COUCHING

“Couching” defines the act of applying a yarn or cord to
fabric with a stitch. Creative presser feet make this task
easy and enjoyable. Each foot has a specified purpose
yielding a different effect (see page 37). Pick a foot and a
cord that works with it. Select a decorative thread and a
decorative stitch. Let your imagination soar as you sew
around the appliqué shape, both inside and outside of the
appliqué stitches.
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REACH FOR THE STARS by Marlis Bennett

SUGGESTED STITCHES
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FACED APPLIQUE

DIMENSIONAL APPLIQUE

INVISIBLE APPLIQUE
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BLANKET STITCH APPLIQUE

SATIN STITCH APPLIQUE



BY JILL DANKLEFSEN 
& MARLIS BENNETT
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• Fabric for use in the printer such as Printed Treasures,
Crafter’s Images Photo Fabric, Colorfast Printer Fabric™

Sheets, or Photo Effects’ Transfer Magic

• Assorted fabrics in a variety of colors:
- Inner Border – One 11/2” wide strip, about 40” long (may

be pieced)
- Cornerstones – Sixteen 2” x 2” squares of four different

fabrics
- Outer Border – Approximately 20 strips of varying

widths from 11/4 -21/2”, each about 15” long
- Backing – 22” x 22”

• Low-loft batting – 20” x 20”
• Temporary spray adhesive
• Assorted embroidery threads in colors to coordinate with

the fabrics
• Assorted presser feet and fibers as desired for couching

(see “Sew Touchable” on page 37)
• Patchwork Foot #37 or Patchwork Foot with Guide #57 for

piecing
• Walking Foot #50 for binding
• Rotary cutter and mat
• “Cut for the Cure” Wedge Ruler 

Supplies



T H R O U G H  T H E  N E E D L E

36

The centerpiece of this colorful mini-quilt features the artwork
of elinor peace bailey, known for her fun spirit and unique
dolls. The rich fairies in this small wall hanging, surrounded
by a vibrant pieced border, love to watch over sewing spaces
to make sure all of your projects go together just as planned.

Printing
Download fairy design from www.berninausa.com (What’s New
> Free Downloads > Free Fairy Artwork). Print the design onto
fabric and trim to be 73/4” x 73/4“.

Piecing 
Inner Border – Stitch borders to the sides of the printed fairy
fabric, trimming strips ends even with the raw edges of the block.
Add borders to the upper and lower edges, trimming strips to fit.
Press seam allowances toward the border strips. 

Cornerstones – Cut sixteen 2” squares, four each from four
different fabrics. Stitch squares together in sets of two; stitch pairs
together to make a total of four 4-patch squares.

Outer Border – Stitch sets of four strips together lengthwise
as desired using Patchwork Foot #37 or Patchwork Foot
with Guide #57 for perfect 1/4” seam allowances. Add decorative
stitches and couched fibers to the seamlines as desired (see
“Sew Touchable” on page 37). Before pressing the seams of the
stitched strips, decide the type of couching and/or decorative
stitching you will use:

• Press seam OPEN if decorative stitches or couched smooth
cords/yarn are to be applied exactly along the seamline
between two strips.

• Press seam TO ONE SIDE if decorative stitching is to be
applied to only one strip edge or if a textured cord/yarn is to
be applied between two strips.

Using the wedge ruler, cut the pieced outer border strips
into “triangular” pieces. Reassemble wedges, placing pieces ran-
domly, to form one long patchwork outer border piece. Cut into
four 61/2“ x 83/4” rectangles. Stitch a 4-patch block to each end of

two of the strips.
Stitch the side borders
to the center block,
then attach the upper
and lower borders
with cornerstones.

More Embellishing
Using temporary spray adhesive, bond the batting to the wrong
side of the pieced top. 

Couch narrow metallic cord (or fiber of your choice) between the
wedges of the outer border and along the inner edge of the inner
border (Superior Razzle Dazzle used on the sample). 

Attach Freemotion Couching Foot #43 (available late 2005) to
the machine. Couch fiber of your choice in an all-over pattern as
desired to the 4-patch corner blocks.

Couch a heavy yarn/cord over the main seams of the wall-
hanging, creating a “tic-tac-toe” effect.

Finishing 
When embellishing is complete, trim top/batting to 19” x 19”. 

Place the backing wrong side up and center the pieced top/bat-
ting on it; use spray adhesive to secure. Trim backing so that 1”
extends beyond each edge.

Fold the backing fabric to the front twice to form the binding,
(first fold: raw edge of backing to raw edge of batting; second
fold; wrap to front of quilt) mitering the corners. Stitch in place
using Walking Foot #50 and a blanket stitch.

Optional Embellishments 
for the Fairy

Add some glamour to the fairy artwork by playing  “dress-up” with
beads, buttons, stitches, etc. Try some of the following:

• Stitch fibers over the fairy’s hair to add dimension and style; top
with a bow or button “barrette”.

• Add quilting to the fairy wings by straight stitching the outline
and then filling in with stitched lines, loosely following the
drawing.

• Stitch small seed beads on the eyes of the fairies.

• Stitch small beads on the neck of the faires to simulate a
necklace and on the ears for earrings.

• Stipple-quilt the background around the fairies to make them
stand out 

• Attach crystals and jewels to the fairies’ clothing using the EZ
Glitzer.



EMBROIDERY FOOT #6
The hole in the center of this foot
does a beautiful job of guiding
a single cord. It also has a
cutout underneath the foot to

accommodate – or simply ride next
to or on top of – heavy stitching. Cord

must be uniform in diameter to flow smoothly
through the guide.

CLEAR EMBROIDERY FOOT #39
This foot is very similar to
Embroidery Foot #6, with the
hole in the center of the foot and
the cutout underneath it, but, as

the name implies, it is clear. You
have great visibility with this foot!

Cord must be uniform in diameter to flow smoothly
through the guide.

EDGESTITCH FOOT #10/10C
This foot can be used to couch
yarns with interesting and/or
variable textures. It is available
in both 5mm and 9mm versions.

BULKY OVERLOCK FOOT #12/12C
This foot is commonly used for making and
attaching piping, but is also wonderful for
couching thick and/or extremely
textured cords. Owners of

machines with 9mm feed (artista
200, 185, 180 and 1630) may choose

Foot #12C as an option. It is a combination of
Bulky Overlock Foot #12 and Braiding Foot #21.

OPEN EMBROIDERY FOOT #20/20C
This foot is frequently used for heavy

satin stitching techniques, but is also
great for applying decorative
ribbons and other flat trims. It is
available in both 5mm and  9mm

versions

BRAIDING FOOT #21/12C
This foot is excellent for  couching
medium to heavy weight yarns or
cords, including satin rattail cord.
This foot is also superb for couching

cords/yarns that have a “slubby”
texture – thick and thin sections. Create your own

combination of twisted cords to couch with this foot. Owners of
machines with 9mm feed (artista 200, 185, 180 and 1630) may choose
Foot #12C as an option. It is a combination of Bulky Overlock Foot #12
and Braiding Foot #21.

CORDING FEET #22 & #25
These feet enable you to
couch up to five parallel
cords at one time. Foot #22
has three grooves and allows

the use of slightly thicker yarns
or ribbons than Foot #25, which

has five grooves and works well with finer threads and yarns.

FREEMOTION COUCHING FOOT #43
This unique foot (available in late
2005) gives the ability to freemo-
tion couch a yarn/cord in a ran-
dom manner, as the feed dogs are

dropped for the couching process.
The foot is designed to use straight stitch

for the application process.

Add texture, depth, and dimension to fabric using the great yarns and heavy
cord available today. Using simple couching techniques and accessories, deco-
rating fabric with additional texture couldn’t be easier! The most difficult choice
is which fun yarn or cord to use first – there are so many to choose from!

Couching is a process in which thick threads, yarns or other
decorative notions such as beads, ribbon, and sequins are
placed on the fabric surface and secured by stitching them
in place, usually with a zigzag or decorative stitch.

Couched embellishments can be applied
at any step of the creative process: during

the strip-piecing process, after the strips have been cut and reassembled – in other words, “couched-
in-the-ditch”, or over a piece of whole cloth. Use as is or cut into strips to be sewn back together.

FABRIC + CORD + THREAD
The choices of these three elements affect the look of the finished technique:

• Match the thread color to the fabric to give the illusion of the cord being woven into the fabric.
• Match the thread color to the cord to give the cord a more pronounced look.
• Match the colors of the fabric, cord, and thread to create texture on the surface of the fabric.
• “Invisible” thread makes the cord appear to float on the fabric surface.

Sew 
Touchable…
An Encounter with Fabulous 
Fibers & Feet
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Fiber selection determines which presser foot is recommended for couching. BERNINA® offers several choices:
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BY CINDY MICHAELS

FACTS:
1. Scrapbookers love paper, and collect lots of it.

2. Sewers love fabrics and threads, and usually
have a large “stash”.

3. Crafters love to cut, snip, glue and sew,
all to combine and create.

What happens when all three of these
creative types of people, the scrap-
booker, the crafter, and the sewer,
are combined in one person? Well,
the results can be truly amazing,
especially when you add today’s
easy-to-use sewing machines, with
their many and varied decorative stitches,
beautiful embroidery, editing and design software,
variable alphabets, and digitizing and appliqué tools. You
can create almost anything – if you can think it, you can
create it.

If you’re one of these creative people, venture into the
world of Sew-Scrapping – scrapbooking by machine – and
see what happens. To create truly memorable and unique
scrapbook pages, you’ll need specific tools and products
to meet your scrapping goals. 

Q. Paper or fabric?

A. Either – or a combination of the two. 

Select papers with a high fiber content. Dense handmade
papers work well; also those with extra texture created by
threads, leaves, or seeds, as long as these fibers are not
too large or too stiff.

To sew on paper, first try some of the decorative stitches
on your sewing machine. Be careful in your selection, and
remember that heavy satin stitches may tear the paper
and destroy your design. Always back the paper with 
stabilizer, such as OESD Ultra Clean and Tear or 
Stabil-Stick, to give the stitches a solid foundation.
Change needles often, as sewing through paper will dull
them quickly. Photocopy or scan and print your photos

This

striking page

starts with a richly

textured paper and a “wow”

photo commemorating an 

important life event. Transfer the photo

to fabric, enlarging or reducing to fit the

page; arrange on the page as desired.

Select a decorative stitch that sews from

side to side and sew the fabric photo to

the page. Add the lettering by hooping

Aqua Film and organdy. Embroider the

titles, unhoop, and trim to fit the space on

the page. Secure by stitching with invisible

thread or fabric adhesive.
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(black and white or color as desired), so that the originals are not
damaged accidentally. Use decorative stitches to create borders
and/or to appliqué your photo(s) onto the page. Add more decorative
stitches or stitch combinations around the outside of the photo(s) 
(see “Stitch Recipes” in each issue of Through the Needle or visit
www.berninausa.com > Sewing Studio). 

Creating pages with fabric offers design options beyond those offered
by paper, such as photo transfer onto designer fabrics, and pieced and
quilted pages. Photo transfer onto fabric can be accomplished in
several ways. Use printable fabrics that are sized to fit and created
with chemical formulas that enable ink jet printing, or prepare your own
fabrics using a product called Bubble Jet Set 2000. This is a longer
process, but allows the use of beautiful fabrics in colors other than
beige or white.

Q. If a picture is worth 1000 words, why add anything else to 
your page?

A. According to Cindy Losekamp, author of Fabri-Scrapping, “The pictures
are the heart and the words are the soul” of your scrapbook page.

“Journaling” can be stitched on your pages with sewing machine
characters or with lettering from embroidery software. The BERNINA®

Designer Plus v4 Embroidery Software Software has 50 fonts, and
allows the use of TrueType fonts installed on your computer. This gives
you a world of possibilities for creating descriptions, names, and dates
for your pages. Stitch lettering on fabric supported by a layer of
stabilizer.

Quilted pages may be embellished with the appliqué and craft stitches
in the BERNINA® embroidery software, or the quilting and decorative
stitches of your sewing machine. Learn more about embroidery
software at your local BERNINA® store, and visit www.berninausa.com
for on-line classes.

Q. How do I make sure the images for my scrapbook pages are the 
highest quality?

A. Start with quality equipment to create and prepare your images.

Digital cameras are wonderful tools for creating beautiful photos to use
in these projects. When considering photo transfer, keep in mind the
quality of your photographs. A great resource, found at bookstores and
online at www.simplescrapbooksmag.com, is A Simple Guide to Digital
Scrapbooking. It’s full of good information on what to look for when
selectimg photography equipment. 

Hints: 

Cameras come with a wide range of options and pricing. Look for high
capacity memory cards, CCD (image size) of 3 mega pixels or higher,
and optical zoom lens of 3x or greater.

Scanners are also available with a variety of options. Look for a scanner
with 1200dpi (dots per inch) or greater, bit depth of at least 24 bits,
and high quality software. 

Your printer should have an acceptable print speed (however long you’re
willing to wait), an expanded range of colored inks (archival quality), with
black ink optimized for photos or text. 

General Sew-Scrap 
Tools and Supplies

• Sewing and embroidery machine, in
good working order, i.e. the artista
200E, 185E, 165E, or deco 330
combined with any model of sewing
machine

• A good camera, ink jet printer, and
scanner

• Software: BERNINA® Designer Plus
Software v4 (with Auto Appliqué) 

• Explorations Software

• Graphics program such as Paint
Shop Pro

• Adobe PhotoShop Elements  
(a photo-editing program with lots
of tools for creating special effects
and touching up photos)  

• A variety of decorative threads 

• Sewing tools such as scissors,
needles, rotary cutter, rulers, and
mat

• Spray adhesives, both temporary
and permanent

• Stabilizers for paper and fabric

• Fusible web and fusible fleece for
quilted pages

• Scrapbooking paper

• Fabrics of choice – light to medium
weight in white, beige, and pastel
colors

• Bubble Jet Set 2000

Books and magazines 
for reference and inspiration:

• Through the Needle magazine 

• Paper and Embroidery magazine

• Fabri-Scrapping by Cindy Losekamp

• Quilted Scrapbooks from Memory
Makers magazine

• Memory Quilts in the Making from
Leisure Arts 

• Fabric Photo Play by J. Wood
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BY HANS HERZOG

Even sewing machines need a little TLC every once in a while. Lint build-up in the hook and
feed dog area, as well as between the top tension disks, can cause excessive wear, noise and
tension issues. Clean and oil your machine frequently, and your machine will reward you with
years of trouble-free operation.

Note: BERNINA® machines have either an oscillating hook system or a rotary hook system, which
is the mechanism that the bobbin case fits into. Each type is cleaned and oiled using slightly
different methods. Oscillating Hook System (activa 125-240, virtuosa 130-160, aurora 430-440,
artista 165-170); Rotary Hook System (1008, artista 180-200)

CLEANING & OILING
Bobbin Area
• Remove the needle plate and bobbin

case and hook. Oscillating Hook
System only: Remove the hook.

• With a lint brush, clean around the feed
dog, the hook and the surrounding area.
Oscillating Hook System only: Clean 
the hook.

• Clean the bobbin case.

Tension Area

• Lift the presser foot bar and using a lint
brush, clean each side of the top tension
discs. Lower the presser foot bar and
use a length of buttonhole twist or
Cordonnet to floss each side of the top
tension discs (see photo). 

• Check the take-up lever for jammed
thread ends; if found, gently remove or
take to a trained technician.

Oiling

• Oscillating Hook System only: Reinstall the hook if it was removed when clearing the lint.
• Place one drop or two drops of oil in the areas shown, or as

indicated in your BERNINA®

Guide and Instruction Manual.
• Insert the bobbin case as
instructed in the manual. Note: If
machine is accidentally over-oiled,
sew several lines of stitching on a
scrap of fabric to remove the
excess.

Make Your Sewing 
Machine Happy!
The following short list details the key
points of caring for your sewing
machine.

NEEDLES – Use only needles made to
fit your brand and model of machine.
In general, BERNINA® and Schmetz
needles are appropriate for BERNINA®

machines. Needles should be replaced
after 6-8 hours of sewing.

THREAD – Select high quality, long
staple thread to minimize the amount
of fuzz and lint deposited in the
machine. Inexpensive “bargain” thread
can deposit large amounts of lint that
build up in the feed dog and tension
areas and can cause tension
inconsistencies over time.

ROUTINE CLEANING – After every
sewing session remove the throat plate
to brush out the lint and fuzz that
accumulates around the feed dog and
bobbin area. Floss the tension disks as
in the photo at left.

REGULAR LUBRICATION – Oil as
recommended by your sewing machine
manufacturer using only the appropriate
oil. Do not use household oil or spray
lubricant on your machine. While some
BERNINA® sewing machines display a
message when it is time to lubricate the
hook, there are times – such as when
using linty threads and fabric – when
more frequent cleaning and oiling is
warranted, particularly in machines that
have a rotary hook systems.

YEARLY SERVICE – In addition to
regular maintenance, take your
BERNINA® sewing machine to an
authorized BERNINA® dealer for an
annual check-up (schedule this before
the “sewing season” starts and during
time away from home so you won’t miss
your machine while it’s gone!) The
trained technician will remove all the
covers, clean and lubricate the interior
parts, and check the overall condition of
your machine. He/she will also test and
adjust the machine to meet the manufac-
turer’s specifications, and perform any
factory-recommended updates. 

Conscientious upkeep of your machine
will keep it at peak performance for
years of uninterrupted sewing pleasure!Oiling the rotary hook system

Floss both sides of the tension disk.

Oiling the oscillating hook system

Brush lint out; don’t
blow it in! Use the brush
included with your machine or use a make-up (blush or
powder) brush or a small paintbrush  to remove lint.
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BY JENNIFER GIGAS

Residing within the version 4 Designer Plus level of BERNINA® Embroidery
Software is a wonderful range of features that lend themselves beautifully
to quilting techniques. Try your hand at foundation piecing, appliqué, and

creating new blocks. Digitizing “freemotion” quilt motifs or tiny stipple stitches that
are the envy of everyone in your guild is just the beginning of what you can create
with this powerful, easy-to-use software package. 

Foundation Piecing

Teach your artista to paper piece!

Creating the Embroidery File
Note: Before starting this exer-
cise, change the settings on your
computer to inches if needed.
Go to Control Panel > Regional
Options > Measurement System
to make this change. For settings

to take effect, the embroidery software must be closed and re-opened.

Work through the Mastering Your BERNINA® Embroidery
Software workbook to familiarize yourself with the Designer
Plus software. The workbook, available from your BERNINA®

dealer, is used in conjunction with your owner’s manual and
will acquaint you with the functionality of the software and
provide a reference point as you begin to fully explore
Designer Plus.

Tools and icons 
used for this 
technique:

Quilter Program

Quilt Layout

Show All

Load Picture

Object Properties

Rectangle tool

Open Curve

Blackwork Run

• Open Designer Plus V4.0 Embroidery
Software, then open the BERNINA® Quilter
program. Click on the Quilt Layout icon;
select 1 block across and 1 block down;
click OK. Click on the Show All icon. Select
Simple Blocks > Simple 1 (the first block in
the fifth row), click on the blank block to
assign the pattern. 

• Print and scan the block or make a Copy
(screen capture) of the block using the
Print Screen key (see your computer manu-
al for instructions]. Open a graphics pro-
gram (Paint, Paint Shop Pro, PhotoShop),
create a New file, and Paste the image.
Crop the block and Save As Square in a
Square.jpg in your My Designs folder. 

• Return to the Designer Plus window. Click
on the Picture Tab; click on the Load
Picture icon; select My Designs folder >
Square in a Square > Open.

• Select graphic, open the Object Properties
box and change the height and width
settings to 5”. Note: 1/4” seam allowances
for the block will be added later.

• Select the Open Curve tool, single stitch
and C1. Digitize all lines on block. Select
the lines; select Blackwork Run. (Color 1
establishes the fabric placement lines
when the block is embroidered.)

• Select the Open Curve tool, single stitch
and C2. Digitize the stitching line around
segment 1. 

• Select C3; digitize the stitching line
between  segment 1 and top segment 2.
Select C4, digitize the stitching line
between 1 and bottom segment 3.
Continue changing thread colors and
digitizing the stitching lines in the same
order they would be traditionally sewn,
using numbers on the graphic as a guide.



• Select All; select Group. Select the Rectangle
tool, Outline = Single, C20. Digitize a square
around the graphic. Tip: Hold down the
control key to draw a perfect square.

• Select the square; open the Object
Properties box and change the height and
width to 5.5”.

• Select All > Align Centers. Click away to
deselect.

• Select the grouped portion of the design.
Ungroup.

• Select All. Arrange > Sequence by Color.
When the dialog box opens, move C20 to
the first position.

• Select Picture Tab. Delete the graphic.
Save design as Square in a square-5 block.
Send to embroidery machine by direct link,
Personal Design Card, or CD.

Stitching the Block
• Select the design file (Square in a square-5

block). 

• Hoop a layer of tear-away stabilizer. Insert 
a fresh needle into machine, NO thread in the needle or bobbin. Stitch colors 1
(cutting line) and 2 (fabric placement lines). Note: Turn off upper and lower
thread sensors.

• Thread machine with 60-weight cotton thread in the needle and bobbin. Place a
square of fabric over the marked center segment. 

• Stitch color 3. Carefully trim excess fabric leaving 1/4” allowance. 

• Position fabric for segment 2 right sides together with segment 1, placing seam
allowance over the marked line. Stitch. Repeat for segment 3.  

• Remove hoop from machine, but do not remove fabric from hoop. Flip
segments open; trim seam allowances; press.

• Repeat for all remaining segments.

• Remove completely pieced block from hoop.
Press block; trim along outside markings. 

Appliqué
Create fabric appliqué shapes for your next project! 

Note: When creating appliqués in BERNINA® Quilter, you are designing appliqué
patterns for stitching by hand or by sewing machine, not embroidered appliqués.
If you wish to add embroidered appliqués to your quilt top, digitize them in
Designer Plus and insert the file as you would any other embroidery design. For
more information refer to Software Owner’s Manual: Chapter 40 – BERNINA®

Quilter Editing.

Creating Appliqués
• Open the Quilter program. Open the Quilt Layout dialog box. Select Rectangular

format, one block
across and down,
10” square. Add a
2” mitered border.
Click OK. Select
the Show All icon.

• Select the Load
Picture icon from
the Edit toolbar.
From Samples
3, select tulip
heart.bmp;
Open.

• Select the 
graphic. Left 
click on one of 
the corner 
control points, 
drag the point

diagonally to rescale the graphic to fit the
block. While the graphic is selected, hold
down the Ctrl key, select the block, and click
the Align Centers icon. 

• Select 5 fabrics (background heart, flower,
flower center, leaf fabric, detail swirl) from
the Library and send to Palette by clicking
on the To Palette button at the bottom of
the Layout menu.

• Select the fabric for the heart shape; select
the Draw Appliqué tool. 

• Click to set boundary around the heart:
right clicks set curves, left clicks set cor-
ners, backspace erases the last point set.
When the first boundary is complete, press
Enter. Press Enter again to complete the
shape. Select the heart appliqué; send
backwards.

• Create appliqué pieces for the left flower
and swirl: select fabric for the flower center,
select the Draw Appliqué tool, and click
points to set the boundary. Repeat for outer

Tools and icons 
used for this 
technique:

Quilter Program

Quilt Layout

Show All

Load Picture

Object Properties

Draw Applique

Align Centers

Send Backwards

Group

Copy

Paste

Mirror Horizontal

9

5

2

3

1

6

4

7 8
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Foundation piecing is especially helpful 
for patterns that have intricate designs 
and/or multiple points such as the star 
block shown here.
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flower section and leaves. Note: Once appliqué shapes have been created, they
may be reshaped using the Reshape Object tool on the Edit toolbar.

• Select appliqué flowers, leaves, and swirl; select Group (or press Ctrl + G);
select Copy and Paste. While the duplicated shapes are selected, engage
Mirror Horizontal; move them to the right. (Note: there is no need to include the
stems, as these will be created from bias strips – no pattern piece is needed.) 

• Delete the graphic.

• Fill the background and borders with fabrics of your choice.

• Select Print Preview; select Appliqué; click Print.

• Cut out the shapes, and use as patterns for appliqué shapes.

Create “New Blocks”

Preview your original block designs before
cutting and sewing! Although there is no way to
import new blocks into BERNINA® Quilter, using
the appliqué tools within Quilter provides a means to visualize blocks in the
settings and fabrics desired. 

Designing the Block
• Open the Quilter program. Open the Quilt Layout dialog box. Select Rectangular

format, 3 blocks across and 4 down, 10” square. Add a 3” mitered border, if
desired. Press OK. Click on the Show All icon.

• Select the Load Picture icon from the Edit toolbar. From My Designs > Quilting,
select quilting design.bmp; open.

• Select the graphic. Left click on one of the corner control points, drag the point
diagonally to rescale the graphic to fit in a block. While the graphic is selected,
hold down the Ctrl key, select the block and align centers. 

• Select four colors (A, B, C and D to correspond with block segments) from the
Colors Library and send to Palette.

• Select a color for segment A (working in the upper left hand quadrant). Select
the Draw Appliqué tool. Set boundary points around the segment: right clicks
set curves, left clicks set corners, backspace erases the last point. When the
first boundary is complete, press Enter. Press Enter again to complete the

shape. Note: Use the Zoom Box tool for a magnified view of
the block segment. 

• Repeat for B, C and D segments of the quadrant. Select
all parts of the quadrant, Group. Copy and Paste into
remaining quadrants, using the Rotate Clockwise/-
Counterclockwise tool as needed. Select and Group
all quadrants.

• Copy and Paste into remaining layout blocks as desired.

Tools and icons 
used for this 
technique:

Quilter Program

Quilt Layout

Show All

Load Picture

Object Properties

Draw Applique

Align Centers

Zoom Box

Group

Copy

Paste

Rotate CCW

To use your new block in 
future layouts, open the

BERNINA® Quilter file 
containing the created block,

and Copy one block 
from the layout. Paste into 

the new layout. When 
re-coloring blocks, drop the

new color over the 
appropriate Colors Used 
color chip, or ungroup 

each segment to recolor 
individual sections.
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BY FAITH REYNOLDS

As an embroiderer, don’t limit yourself

to thinking that the sizes of your

designs are limited to the size of the hoops

that came with your embroidery system.

These new hoops from Hoop-It-All™ make it

easy to stitch a large design in four

quadrants, rotating the hoop 90° for each

stitching. This beautiful floral arrangement

starts with an embroidered outline quilting

design and blooms into a stitched square,

12” x 12” (design is 10” x 10”). Perfect

for the center of a medallion quilt or a

striking table covering.

SUPPLIES

• Any artista embroidery system

• 14” square of 100% cotton fabric, pre-washed 

• 14” square of low-loft batting

• Quilting Inspirations Embroidery collection by Keryn Emmerson

• Jeans Stitch thread by YLI, variegated (needle)

• All-purpose polyester (bobbin)

• Topstitch needle 

• Hoop-It-All™ Quilter’s Square Double Wide Hoop or other appropriate
Hoop-It-All™ for your artista model

• Stabil Stick adhesive-backed stabilizer

• Temporary spray adhesive

• BERNINA® V4 Embroidery Software – any level, including Editor Lite Software

• Fabric marking chalk
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DIRECTIONS

Open the BERNINA® V4 Embroidery Software program.

Select design #45 from the Quilting Inspirations Embroidery collection by Keryn Emmerson.

Resize the design to 90% (should measure approximately 5” square - 5.03” x 5.06”).

Add a second color to the color bar by selecting Settings > Thread Colors. Change Threads in
Design to 2; click OK. This second color will be used to add a reference line for positioning.

Select the appropriate hoop for your machine; in this case, artista 255 x 145 Oval w/ XY Lines
was selected for use with the 200E and 185E. Keep the default hoop setting on “Automatic
Centering.”

Select the design and make a copy (Copy and Paste). Rotate the copy 90° clockwise and move it
below the first design.

Copy and Paste the first two designs and rotate 180°. Select Show All. Use the arrow keys to
move the copies to the opposite side of the original designs.

Add a Reference Line: Select the second color. Using the
Measure tool in the software (View > Measure), measure up
0.5” from the center of the XY axis hoop center. Using the
Open Curve tool and a single outline stitch, digitize a small
line starting 0.5” from the center and ending at the edge of
the basket.

Open Color Film and move the box containing the line to
the beginning of the design. Every time you sew the design,
you will measure 1/2” up from the center of the fabric and
the needle should be over the center vertical line 0.5” up
from the XY axis on the fabric. 

Delete the lower two designs and the top left design. You will then have only one basket and one
reference line. You will stitch this design four times, rotating the hoop 90° before each stitching. 

From the drop down menu select Arrange > Start and End. Select the start point to be the First
Stitch in the design; click OK.

Save the design as Basket Hoop It All.ART.

Place Stabil Stick stabilizer on the back of the hoop with the sticky side facing up.  

Using temporary spray adhesive, bond batting to the wrong side of the fabric square.

Fold the fabric into
quarters and crease lightly
to mark the horizontal and
vertical centers. Place the
folded fabric on the hoop
in one quandrant as
shown. Unfold the fabric
and smooth in place;
lightly mark a cross in the
center of the fabric with
chalk. Measure and mark 1/2” from center on all four sides.

Put the hoop on the machine and adjust the slide hoop attachment until the needle is even with the
1/2” mark. Use the Move Hoop or Move Motif function (depending on your model) to move the
hoop or design till the needle is directly over the centerline at the 1/2” mark.

After embroidering the first 
design (Step 1), take the hoop off 

the machine and rotate the 
hoop counterclockwise. Slide the

hoop attachment on the 
left side of the hoop and repeat 
the steps taken to position the 

first design. Embroider the design 
again (Step 2). Continue 
until design is complete 

(Steps 3 and 4).

STEP 2

STEP 3

STEP 4

STEP 1
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BY JENNIFER GIGAS

Note: All examples in this article may be reproduced using
Editor Lite (included with the BERNINA® models aurora 430
and 440 QE). Other levels of BERNINA® Embroidery Software
(Editor, Auto Designer, Designer Plus) can perform the same
functions but will not have the same designs. For additional
examples of lettering manipulation see Through the
Needle, Issue #11.

DESIGNING MONOGRAMS

Typically a monogram consists of the first, middle,
and last initials; the last initial is often larger
than the other two letters and placed in the
center to designate the family name.
Small, embroidered elements inter-
twined with the letters add a touch of
elegance and nostalgia to the monogram.
A single letter surrounded by embroidered
elements is a nice way to personalize an item
shared by members of the same household.

Note: The following exercises use the tools and
functions described in the article “Making Changes,”
found on page 10 of this magazine. Refer back to this
information or the owner’s manual as needed.

THE SINGLE LETTER MONOGRAM

• Press the letter A on the keyboard. This opens the lettering Object
Properties dialog box. From here, lettering style, size, justification

and baselines may be
selected.

• Choose King
Charles from the

alphabet drop
down menu.

• Type the letter B in
the text screen. Press OK.

• Click on the design screen
to set the lettering.

• Select the letter. From the color
drop

down menu,
select C19.

• Reshape the letter
if desired. Right click
on the Scale icon twice
to reduce the size of the
lettering.

1. letter + border 2
2. letter + borders 2 & 3
3. finished monogram

There
is nothing

more personal
than a name; it is the

first gift bestowed upon us as
children and it identified us to the

world. Monograms have long appeared on
linens, pockets and cuffs. Add a bit of editing magic

to a traditional monogram and its style becomes
something unique. Whether your taste is for

the elegant and understated or you
prefer something contempo-

rary, you’ll never look at
monograms the

same way!
2 31
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• Select File > Insert Design.

- Select Black Border 2 > Open.

- While the design is still selected, click and drag one of the corner control points to
scale the motif down until the size is visually pleasing with the “B”.

- Move the design to the left side of the letter.

• Select File > Insert Design.

- Select Black Border 3 > Open.

- Right click on the rotation tool 3x. 

- Position the motif towards the bottom of Black Border 2.

• To move the letter to the top of the design, select it, cut, then paste. The letter is now in
front of the flower and will be the last thing embroidered.

• Send the monogram to the embroidery machine for stitching.

THE 3-LETTER MONOGRAM

To maintain the maximum editing capabilities, each of the  letters for the monogram
will be created individually. Text entered at one time
becomes one object; changes made to one letter
affect all of the text in that object.

• Press the letter A on the keyboard. This opens
the lettering Object Properties dialog box.
From here, lettering style, size, justifica-
tion and baselines may be selected.

• Choose King Charles from the alphabet drop down menu.

• Enter your first initial in the dialog box. Press OK. 

• Click on the design area to generate the lettering
object. Click away to deselect.

• Repeat for your last initial.

• Repeat for middle initial.

• Select the last letter initial; increase the
size of the letter by clicking and drag-
ging on the sizing handles.
Experiment with independent
height and width adjustments.

• Hold down the Control key
and select the first and
middle initial letters.
Change the color using
the color drop down
menu. Change the
color of the last
initial if
desired.

• Experiment
with reshaping

of the letters.
When satisfied with

the arrangement, select
File > Save As. When

the Save dialog box opens,
name the design file and save

in your My Designs folder.

• Send to the embroidery machine
for stitching.

CREATIVE TOUCHES

Create new looks for your monograms by
experimenting with the size and placement of

the first two initials.

Add small embroidery elements to a monogram for
an embellished look.

Mirror image letters, experiment with rotation, and combine
monograms to create all-over patterns.
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BY FAITH REYNOLDS

Get Started

• Open the BERNINA® Designer Plus Embroidery Software;
select Samples 3 Folder.

• Open Flower and Vine.ART.
• Select from the drop-down menu File > Save As and name

the design Flowers & Vine LargeMaster.ART.

Create A “Too Large” Design For This Exercise

• Select the entire design by using the keyboard shortcut
CTRL+A.

• Rotate the design 90° counterclockwise by right clicking
two times on the Rotate Tool. 

• With the design still selected, open the Object Properties
dialogue box. 

• Select the General tab.
• Change the Width to 165% and the Height to 165% and click

OK.
• Click on the Show All icon to view the entire design.

Analyze the design 

• Right click on the Hoop icon; select the artista 255 x 245
Oval w/X-Y Lines lines.

• From the same screen, select position > Manual;
click OK. 

• Use the arrow keys on the keyboard to move design so
that the top part will fit in the embroidery space of your
hoop. See Picture 1

Divide the Design

• Using the Polygon Select tool, select the objects that fit
in the embroidery space. See Picture 2

• Click on the Group Tool to group all of these objects
together.

• Save the design
You can visually determine that the remainder of the
design—except for the long satin stitched line—will fit in the
embroidery space for the second hooping. At this time,
select and group the remainder of the design with the
exception of the long satin stitched line. See Picture 3

Overview of Process
1. Analyze the design to see how it can be divided into sections

that will fit into your hoop.
2.  Select the parts of design that will fit in the hoop; group and

name  it Section 1.
3. Continue until all sections have been selected, grouped, and

consecutively numbered.
4.  If needed, redigitize a part that can’t be divided; break it into

sections that will fit within the previous hoopings, overlapping
the parts slightly.

5. Group each of the redigitzed sections with one of the
numbered sections.

6. Add a reference line of straight stitching in the center of the
design.

7. Copy and paste this line as many times as you have sections.
8.  Group each section with one of the straight stitch reference

lines.
9.  Stitch the design, rehooping for each section. Align reference

lines for a perfectly stitched design. 
10. When embroidery is complete, unhoop fabric and remove the

reference lines.

Designs larger than the hoop can be stitched by dividing them into
sections and using multiple hoopings to embroider each portion of
the design, piecing them together for the complete design. Use the

design shown here as a practice exercise to learn this technique for divid-
ing any design. Note: This lesson covers the manual process of dividing a
design. If using the Mega Hoop with the artista 200E, the Art Engine of the
sewing computer will automatically split the design into sections.

D



S P E C I A L  C L A S S R O O M  E D I T I O N

49

Re-digitize An Object in the Design

Occasionally when enlarging an existing design, there will be an
object that cannot be split. In this design, the long satin-stitched line
needs to be re-digitized into two shorter pieces.

• Select the satin stitched line and go to Object Properties; you
will see that the width of the line is 0.25” (3.92mm) You want the
line you digitize to be the same width as the original line.

• Without any object on the screen selected, open the Object
Properties dialogue box > Outline Stitch > Satin > change the
width to 0.25 > OK.

• Select the Open Curve Tool and the Satin Outline Stitch.
• Using two different colors, digitize two lines that overlap each

other slightly and that cover the original line in the design.
See Picture 4

• Click on the Selection Tool.
• Select the original satin-stitched line. To select it, hold down the

2 key on the keyboard and click on the line. Note: The 2 key is
used to search for a layer below the one on which you have
clicked.  

• When you see that the whole line has been selected, touch the
Delete key on the keyboard. Don’t forget...you can always touch
the Undo icon if you need to.

• Save the design.

Group The Designs For Easy Handling

• Select the Hoop icon and change the Position setting to
Automatic Centering.

• Select the top part of the satin-stitched line; holding down the
Ctrl key, also select the upper right part of the design. Click on
the Group tool to group these objects together. See Picture 5

• Select the lower part of the satin-stitched line; holding down the
Ctrl key, also select the lower right part of the design. Click on
the Group tool to group these objects together. See Picture 6

Adding A Reference Point

• Zoom in on the area where the two satin-stitched lines meet.  
• Select the Single Outline Stitch. 
• Open the Object Properties dialogue box and change the stitch

length to 5mm.
• Select a new color.
• Draw a horizontal line starting at the left edge of the satin-stitched

line  and ending at the center of the design. See Picture 7

Duplicating The Reference Point

• Click on the Selection tool; the single outline stitch just digitized
will be selected.

• Select Copy>Paste.
• Change the pasted copy to a different color.
• Save the design.

Group First Design With Reference Line

• Open Color Film to make selection easier.
• Scroll to the far right of the color bar and click on the last color

square.
• Hold down the Ctrl key on the keyboard and click on the bottom

part of the design on the desktop.
• Click on the Group tool.

Group Second Design With Reference Line

• With Color Film still open, click on the next to the last color square.
• Hold down the Ctrl key on the keyboard and click on the top

part of the design on the desktop.

• Click on the Group tool.

Save First Design

• Select the bottom design and click on the Cut tool.
• Save as: Flowers & Vine 1.ART.
• Click on Paste.

Save Second Design 

• Select the upper design and touch the Delete key on the
keyboard—don’t  worry, you have already saved this design.

• Open Color Film and move the last color box to the far left.  
• Save as: Flower & Vine 2.ART.

Embroidering The Complete Design

• Prepare the fabric by drawing a vertical line through the center
of the fabric using a water-soluble marker.

• Use the template to hoop the upper part of the design, making
sure that the vertical line on the fabric is below the center
vertical line on the template.

• After embroidering the first design, rehoop the fabric, aligning
the center vertical line and making sure the lower part of the
first design is completely within the embroidery space.

• When the second design is opened in the machine, the needle
will move to the beginning of the reference line.  

• Move the design until the needle is precisely over the first stitch
on the reference line. Stitch without thread to make sure it is
matched up.

• Skip to the second color in the design and embroider.
• After stitching is complete, unhoop the fabric, clip any unwant-

ed threads, and remove the reference lines. See Picture 8

Originally published as an online class at www.berninausa.com.

Picture 3Picture 2Picture 1

Picture 6Picture 5Picture 4

Picture 7 Picture 8

reference line
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BY NANCY BEDNAR

…to create delicate shirring on
an easy and elegant pillow.
Blend beautiful silks and
decorator weight wovens with
the unique feed dog-regulating
feature to make people wonder
“just how did she do that with
a serger?”

MATERIALS 
(for a 14” x 10” rectangular pillow)

Fabrics
• Pillow center (smocked insert): 8” x 42” –

lightweight fabrics work best; sample uses silk
dupioni

• Pillow sides/back/piping: 1/2 yard of 54” wide mid-
weight decorator fabric

Notions
• 11/3 yds. brush fringe
• 2/3 yards 3/8” diameter piping filler cord

• 14” x 10” rectangular pillow form insert
• 4 cones Mettler Metrocor polyester serger thread

Machine
• BERNINA® serger with differential feed and chain-

stitch capabilities:
-Model 1300DCC or 
-Model 009D for smocking plus any other
model for piping and overlock seaming

• Serger Multi Purpose Foot

PREPARATION AND CUTTING
• Center panel (silk) – one piece, 8” x 42” 
• Pillow front sides (stripe) – two pieces, 7” x 14” each
• Pillow back (stripe) – one piece, 17” x 14” 
• Bias piping strips (stripe) – two pieces, 2” x 14” each

DIRECTIONS
Smocked Center Panel
Serger smocking is possible because of a feature
called differential feed. Generally located near the

stitch length dial, it
regulates how fast or
how slow the feed dog
pulls slow fabric. At the
lowest setting, 0.7, the
feed dogs drag the
fabric, slightly stretch-
ing it before it is sewn
by the needles. This is
the rippling look that is
often found on little
girl’s anklets, ribbed
necklines or  elegant
flounces on bridal and
eveningwear. Dial the
differential feed up to
its highest setting,
2.0, and the fabric is
fed faster by the
front feed dogs,
resulting in a kind
of  gathering or
easing before it
is captured by
the needles.
Serging row

Take serging out of the everyday 
mainstream of stretchy seams and 

rolled edges to stitch within 
a piece of fabric… 
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upon row of fabric with closely placed lines of
chainstitching duplicates time-consuming machine
smocking in a very short amount of time. Make sure
that you are working with a single layer of lightweight
fabric for the best possible results. Because light-
weight fabrics will gather quite a bit, always allow at
least 3 times the finished length. Test on a swatch to
see how much is drawn into the smocking. 

Settings for chainstitch smocking
Thread the right needle and side chainstitch looper
with all purpose serger thread. Refer to your serger
manual for threading illustrations. SL: - 4  Differential
Feed: 2.0  Needle tension – slightly tightened – appx
6. Looper tension – M.

Draw a vertical center line on the wrong side
of the silk dupioni. Since the decorative
chainstitch is created by the lower
chainstitch looper, fabric will be
placed underneath the presser
foot wrong side down.

Position the fabric, wrong
side down to stitch on the
chalk marked line. Stitch
along the entire length of
the fabric. Gentle  puckers
will appear.

Continue to chainstitch-smock
in parallel lines, alternating to
the right and left of center
smocking rows approximately 1/2”
apart. Hint: use the width of the serger
presser foot as a spacer between rows and
avoid marking additional guidelines. Continue to fill in
the entire 8” width  of fabric. 

Remove the chainstitch-smocked fabric from the
serger. Gently pull of the fabric on the right and left
sides to straighten the gathers. Lightly steam the
smocking to set the puffing in the rows.

Trim the smocked center panel to 61/2” x 14”.

SERGER PIPING
Set the serger to basic 4-thread overlock seaming with
all purpose serger thread in all 4 positions, all tensions
balanced, appx. 4-5, SL – 2 _, differential feed
returned to Normal.

Install the serger
Multi Purpose Foot
on the serger.

Center one piece of
filler cord on the
wrong side of one
piping bias strip.

Fold over the bias strip, encasing the filler cord.

Place the folded, cord filled strip underneath the Multi
Purpose Foot so that the ridge of the filler cord is
positioned underneath the tunnel located on the
bottom of the foot. 

Serge the bias strip together, positioning the needles
so that they stitch just outside the filler cord, trimming
excess fabric. 

Repeat for remaining piping strip.

Position the finished piping to the right and left sides
of the smocked center panel. Serge the piping to the
pillow center using the Multi Purpose Foot to allow the

ridge in the filler cord to ride smoothly
underneath the presser foot. 

Serge-seam the pillow left and
right fronts to the piped sides of

the smocked center, using the
Multi Purpose Foot. Note: It is
also possible to stitch the
piping and seam on the
side panels simultaneously.

PILLOW TOP
ASSEMBLY

Serge-seam the completed
pillow front to the pillow back,

leaving an opening at one short
side.

Turn the pillow right sides out. Insert the
pillow form into the pillow through the opening.

Slipstitch the opening closed. 

Cut the brush fringe in half. Using a sewing machine,
sew the trim to both the front and back side edges for
a lush, full look. Compressing the pillow form within the
pillow as you stitch will allow you to sew the trim onto a
pillow that is already stuffed.

For more fun 
serger techniques, 
see Creative 
Serging – A 
Comphrehensive 
Guide by Nancy 
Bednar and Anne 
van der Kley. 
Available from 
SterlingPublishing 
in Spring 2005.
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BY LYN LACKEY

Getting Started
Open BERNINA® artista 4.0 Software.

Left-click on the Quilter Program Icon to open Quilter Program.

Left-click on Quilt Layout Icon and create the scrapbook page:
- Blocks across: 1, blocks down: 1

- Width and Height - 12” square which is standard size of a scrapbook page, 
but  you can customize to desired width and height if not using standard 
scrapbook pages

- Left-Click OK and return to Quilter Screen

Left-click on the Show All icon so that the block is large enough to work with easily.

Left-click on Library to choose the block design:
- Open the Block Menu choices

- Left-click on + icon - Buildings blocks, 

- Left-click on house #8

- Click on the 12” block send the block design your block. At this point, you can 
play with color and develop a visual display of the colors to be used on the page.

Creating this “homey”

scrapbook page using

the BERNINA® Quilter

gives you a visual

layout to follow when

putting together the

paper page.

BERNINA® Quilter is

included with all levels

V4 of the BERNINA®

Embroidery Software.

Using the 
BERNINA
Quilter 
software
program to
design 
scrapbook
pages.
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Wirtual Photo Layout
On tool bar, left-click File<load picture

Select your picture file (may be “my documents<my pictures”), depending
on where on the PC, you store your photos and pictures. Click Open

Drag picture to window. While handles are still around picture, resize to fit in
window.

Save in the Quilter Program; remember this design will save as an .arq file. In
order to access it through artista 4.0 software, you must return to the Quilter
Program and then click File<Open

Print out the Quilt Block templates: File > Print Preview > left-click Blocks > left click OK > left-click: Print from top of screen.

Creating the Paper Page
Cut printed templates apart and trace onto various colors of scrapbook paper, card stock
or similar acid free paper of your choice. 

Using OEDD 404 spray adhesive, lay the pieces of your “house” in place. Be careful
that the pieces lie side by side and do not overlap. Of course, your adhesive must be
acid free to preserve your masterpiece!  

Attach Clear Foot #34. Using decorative embroidery thread (Isacord is a good choice  here
because it is color fast, polyester, and quite strong), stitch the pieces in place with decorative
stitches. Select a stitch that goes from side to side such as the feather stitch  or running stitch.

Attach Free Motion Couching Foot #43 and using a grey/black yarn, create the smoke
emerging from chimney.

Attach Button Sew-On Foot #18 - add buttons for flowers in the grass and a doorknob on
the door.

Add lettering of your choice and be sure to leave space for journaling! On this sample, the lettering was embroidered on a
sandwich of 2 layers of OESD Aqua Film, a water soluble stabilizer, with a layer of polyester organdy between.

Hoop the 3 layers and embroider the words of your choice. Trim and adhere to your page in place with 404 spray adhesive.

Scrapbook Sewing Tips
• Decrease width and increase length to sew detailed areas so that stitches do not “overpower” and/or perforate the paper

• Change needle often, as sewing on paper dulls needles points more quickly.

• Adjust size of window to your photos or scan pictures and in a drawing program on your PC, resize them and print 
out on quality photo paper.

• Be sure to leave a space for Journaling. The journaling on this sample will be written between the door and windows.

NOTE: You may 
want to experiment with

the new stiffened 
fabrics that are available.

They are acid free 
and fun to sew on, will 

not ravel or wrinkle.

TIP: Remember 
if you are using paper,
choose open stitches 

or increase length on the
satin stitches to 

prevent the perforation 
of your paper.
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Designing and creating new fashions and fabrics
using collage and couture techniques is all part of

the popular “Koos style” inspired by
designer Koos van den Akker. In the
book, Koos Couture and Collage by
Linda Teufel we see jackets, coats and
dresses created using this signature
technique. We design our own
creations, but then wonder, 

“What goes with wearable art?” 
The answer: “More art!”

In buying materials to create a
collage, such as in the
Koos-inspired
jacket on page 55,
we generally buy
too many fabrics,
and much too much
yardage. What better
way to use the excess
than by creating garments
and accessories to
complete the look? Skirts,
pants, hats, bags, shoes, and
jewelry – all can be made with
the wonderful sewing machines,
tools, accessories, and products
available to us today.

BY CINDY MICHAELS

Koos van den Akker, of 
The Hague, Netherlands,
apprenticed at Christian
Dior in Paris, and in 1968
moved to New York where
he sewed during the night
and sold his creations
during the day. 

He opened his own store
in the mid-70s and became
quite popular with the
Hollywood crowd. His
designs were refreshing

and unique – artfully
designed garments

using a collage of
fabrics. His collage

garments remain
his signature

pieces. With
the renewed

popularity of
patchwork
in clothing,

his style is a
refreshing way to

incorporate a collage of
fabrics into fashion.
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Start with your original wearable art creation,
such as the jacket shown here. Strip-

piecing, embroidery, decorative
stitches, couched threads and

yarns, and appliqué
techniques were used
to create the “fabric”

of the jacket from which
the pattern pieces were

cut, leaving lots of
interesting scraps and leftovers. These went
into a bag and were later used to create the

ensemble.

Where to start? A jacket does not stand
alone; it needs pants, a skirt, or a dress to

complete the look. Details make any simple
project eye-catching and memorable. 

This simple straight skirt, made from the leftover
lavender suede cloth, is a perfect companion for
the jacket. Using some of the bias binding
leftover from the Hong Kong trim on the jacket
and Edgestitch Foot #10/10C, a vine was
stitched across the skirt. Roses – some
embroidered directly on the fabric, others
stitched on Poly Mesh stabilizer and
appliquéd to the skirt – complete the look.
This technique is easy and allows you to
experiment with the placement of the
flowers before stitching them
onto the garment. 

Place the stabilizer in your
embroidery hoop, stitch out the
design, then use a stencil-
burning tool to melt the stabilizer
from around the edge of the
appliqué.



T H R O U G H  T H E  N E E D L E

56

Bags are the “in” thing for
crafters and sewers of all
ages, and make great
gifts. Some are very
simple and quick to make,
such as the “Potato Chip
Bags” featured in Issue #7
of Through the Needle.
Some are more
complicated, with zippers,
pockets, hidden
compartments, ruffled
edges, beaded or
feathered fringes, and/or
handles created with
beads and yarns.

A wardrobe of bags used 
more of the leftovers, including
strips pieced for the jacket.
Handles, unusual lining fabrics,
decorative zippers, and the variety
of closure elements turn the
simple into the divine. Additional
elements – decorative stitches,
freemotion quilting, and more
embroidered roses and leaves –
coordinated the bags to the jacket
and skirt. A variety of materials
and techniques were used to
create the bag handles: braided
yarns, ribbons, rattail cords, beads,
and purchased handles in a variety
of sizes and styles.
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Koos Couture & Collage 
by Linda Chang Teufel

Fashion & Imagination book

Through The Needle magazine 
(BERNINA® of America, Inc.)

Handle With Style 
from Indygo Junction, Inc.

Belle Armoire Art to Wear 
magazine

Simply Sensational Bags 
by Linda McGehee

Embroidered Bags & Purses 
from Krause Publications

Bags With Style 
by Stephanie Kimura 
(patterns included)

Handmade Bags by Terence Terry
(patterns included)

Edges & Finishes in 
Machine Embroidery 

by Valerie Campbell-Harding

The Hip Handbag Book 
by Sherri Haab

Chic & Easy Beading 
by Alice Korach

“Chole Handbag,” 
“Katy Bags,” and more 
from Lazy Girl Designs

“Humbug” Bag 
from Make it Easy

“Mary Ann’s Purse” 
from Mary Ann Sheppard

“If A Bra Can Be A Purse” 
by Vicki Tracy

Remember, these are your creations – inspiring to others, and, 
above all, fun to design and make. Each is unique and interesting, 
from the plainest bag to the most "over-the-top" shoes and hat. 

Have a good time creating your ensemble, shopping for and using 
up your “stash. Remember it only becomes a “collection” if you 

don’t use it! You have permission to let go and create – 
accessorize, accessorize, accessorize!
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A purchased hat
and shoes were

personalized
with additional
embroidered

roses and
leaves, secured
with a glue gun. 

Publications For Instructions and Inspiration:
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BY JENNIFER GIGAS

Prepare the Design:

Open Designer Plus software; insert Tassels and Trims CD into CDRom
drive. Select File > Open. Click on the Look In drop down arrow; locate
the CD drive (usually the D drive). Select design 10.ART; open.

Click twice on the Zoom Out tool.

Choose the Select Object tool. Draw a bounding
box around the entire motif; click on the Group
icon or use the Ctrl + G keyboard shortcut to
group the motif.

Combine machine embroidery 
with traditional quilting techniques to
create a lovely pillow top. Or take the

project further, using this as the 
first block of an elegant quilt.

Supplies Needed:
• Special design collection

included with Tassels and
Trims book

• BERNINA® V4 Designer Plus
Embroidery Software

• Isacord embroidery thread in
desired color

• Lightweight bobbin thread
• Temporary spray adhesive
• BSR (BERNINA® Stitch

Regulator) or Freemotion
Embroidery Foot #24 

• Clear Embroidery Foot #39
• Straight stitch plate
• Three 1/2" buttons
• Rotary cutter and mat
• Nifty Notions “Cut for the

Cure” 14" x 14" Ruler
• 16” square of fabric 
• 16” square of batting 
• 65” of decorator trim
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Create the Tasseled Wreath:
Select the Wreath tool; use the
Wreath Points arrow to change the
number of spokes to 4. Hold down
the Control key (this will position the
duplicates at 45° angles), arrange the
duplicates as shown in the photo, and
left click on the screen to set them
into position. Release the Ctrl key and
click away from the motif to deselect.

Select the motif at the 6:00 position.
Hold down the Control key and select the motif at the 3:00 position.
Continue holding down the Control key while selecting the motif at the
12:00 position, then the motif at the 9:00 position. Select Arrange >
Sequence As Selected.

Create the Stippled Center:
Select the Closed Curve tool and Step Fill. Using right mouse clicks, 
manually digitize a circle inside the wreath.

Fill the wreath with stipple quilting: Select the filled circle. Select the
Stipple tool; when the dialog box appears, click OK. 

Add the Outline Quilting:
Select File > Insert Design. Select MyDesigns > Holice Turnbow Stencil
Quilt Designs > HT102; click Open.

While the outline quilting design is selected, group it, then right click to
open the Object Properties dialog box.

• From the General tab, change the Width and Height to 45%. Click OK. 

• Select Mirror Image Vertical, then left click once on the Rotate tool.
Position the design in the upper left corner of the wreath.

• Select Edit > Duplicate. Rotate CCW twice (two right clicks), move the
duplicate to the lower left corner.

• Select Edit > Duplicate. Rotate CCW twice, move the duplicate to the
lower right corner. 

• Select Edit > Duplicate. Rotate CCW twice, move the duplicate to the
upper right corner.

Tip: When positioning the corners, turn off Auto-Centering and turn on
the grid to define the edges of a square. 

Change the Color Sequence:
• Open Color Film; select the blue color chip. From the Color Status Bar,

select C1. Close Color Film.

• Select Artistic View to preview the design. 

• Send the design to the embroidery machine by direct connect, or by 
saving the design to a Personal Design card or a CD.

Toolbox
The following tools of

BERNINA® V4 Designer
Plus Embroidery Software

are used to create the
design for the pillow

shown in the photograph.

Zoom Out

Select Object

Group

Wreath

Closed Curve

Mirror Image

Vertical Rotate

Color Film
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Embroider the Pillow Top:
• Adhere the batting to the back of the pillow fabric

with temporary spray adhesive. Press from the 
right side.

• Mark the center of the square by drawing lines
along both diagonals. Hoop, keeping the center of
the square in the center of the hoop and aligning the
markings on the fabric with the diagonal lines on
the hoop template.

• Embroider the design in the center of the square.
Remove from hoop; trim jump threads and bobbin
thread from behind the tassels. Press lightly. 

Add a Stitch Recipe
• Mark a line from the center of the top edge of the

square to the center of the right side of the square.

• Mark a line from the center of the right edge to the
center of the lower edge.

• Repeat for the remaining two sides, framing in the
embroidery. Tip: Use Nifty Notions "Cut for the
Cure" 14" x 14" Ruler to draw an 8” square
around the embroidered center, making sure that
the centers and diagonals are aligned.

• Attach Clear Embroidery Foot #39 to the machine.
Select blanket stitch, move the needle position to
the far left, and engage the Horizontal Mirror Image
function. Sew along the marked line, aligning the
right edge of the presser foot with the marked line.

• Press the Clear button to undo the changes made to
the blanket stitch. Move the needle position to the
far left. Sew a second row of blanket stitch, aligning
the right edge of the foot along the previous row of
blanket stitching.

Quilt the Corners:
• If using the BSR (BERNINA® Stitch Regulator), attach

the foot to the machine, lower the feed dog, and
activate the BSR. If not using the BSR, attach
Freemotion Embroidery Foot #24 to the machine. 

• Freemotion stipple-quilt each corner. 

Complete the Pillow:
• Trim the pillow top to 15” x 15”.

• Cut two rectangles of backing fabric: 
A =141/2” x 15”, B = 13” x 15”.  

• Fold under 3” on the 141/2” edge of rectangle A.
Fold under 3”again. 

• Mark buttonhole placement along the fold of the
rectangle. 

• Stitch buttonholes using Automatic Buttonhole
Foot #3C.

• Fold back 3” on the 13” edge of rectangle B. 

• Using the buttonholes on the other rectangle as 
a guide, mark button placement. Sew buttons in
place using Button Sew-On Foot #18 and the
button sew-on stitch.

• Button rectangles together. Baste across outer edges
where the rectangles overlap.

• Using Clear Embroidery Foot #39, baste trim to
pillow front, aligning raw edges and mitering corners. 

• Stitch front to back, right sides together, sandwiching
the basted trim between the layers. Tip: Unbutton
center button before stitching edges together for ease
in turning pillow cover right side out.

• Trim corners; turn cover right side out. Insert pillow
form; button opening closed.






